
Intel® Endpoint Management
Assistant
(Intel® EMA)

Server Installation Guide

Intel® EMA Version: 1.12.1

Document update date: Tuesday, November 21, 2023



Legal Disclaimer
Copyright 2018-2023 Intel Corporation.

This software and the related documents are Intel copyrighted materials, and your use of them is governed by the
express license under which they were provided to you ("License"). Unless the License provides otherwise, you
may not use, modify, copy, publish, distribute, disclose or transmit this software or the related documents without
Intel's prior written permission.

This software and the related documents are provided as is, with no express or implied warranties, other than those
that are expressly stated in the License.

Intel technologies may require enabled hardware, software or service activation.

No product or component can be absolutely secure.

Your costs and results may vary.

No license (express or implied, by estoppel or otherwise) to any intellectual property rights is granted by this
document.

Intel disclaims all express and implied warranties, including without limitation, the implied warranties of
merchantability, fitness for a particular purpose, and non-infringement, as well as any warranty arising from course
of performance, course of dealing, or usage in trade.

The products and services described may contain defects or errors known as errata which may cause deviations
from published specifications. Current characterized errata are available on request.

Intel technologies’ features and benefits depend on system configuration and may require enabled hardware,
software or service activation. Performance varies depending on system configuration. No computer system can be
absolutely secure. Intel does not assume any liability for lost or stolen data or systems or any damages resulting
from such losses. Check with your system manufacturer or retailer or learn more at
http://www.intel.com/technology/vpro.

Intel, the Intel logo, and other Intel marks are trademarks of Intel Corporation or its subsidiaries. Other names and
brands may be claimed as the property of others.

http://www.intel.com/technology/vpro


1 Introduction 1

1.1 Before You Begin 1

1.2 Supported Operating Systems 2

1.3 Installation Prerequisites 2

1.3.1 Computer 2

1.3.2 Operating System 2

1.3.3 Database 3

1.3.4 Pre-installation Instructions for Microsoft Azure AD Environments 4

1.3.5 Web Server 4

1.3.6 Intel® AMT PKI Certificate 5

1.3.7 Microsoft .NET Framework Versions 5

1.3.8 Firewall 5

1.3.9 Network 5

1.3.10 Network Ports 5

1.4 Security Recommendations 7

1.4.1 Perform a Backup of Important Data 7

1.4.2 Modify the Access Control List (ACL) for Key Configuration Files 7

1.4.3 Enable Transparent Data Encryption on SQL Server Enterprise 8

1.4.4 Secure all Certificates and Keys 8

1.4.5 Samples files for Intel® EMA REST API and JavaScript library 8

1.4.6 Disable Insecure Cipher Suites 8

1.4.7 Strong Encryption Protocols 9

1.4.8 IIS – Replace the Temporary Web TLS Certificate 9

1.4.9 IIS – Change IIS User Account 10

1.4.10 IIS – Enabling the Transport Layer Security Protocol 10

1.4.11 IIS – Machine Key Validation Method 11

1.4.12 IIS – Restrict Unlisted IIS Extensions Execution 11

1.4.13 IIS – Dynamic IP Address Restrictions 11

1.4.14 IIS – Configure Host Headers for All Sites 11

1.4.15 IIS - Review updated web.config File 11

1.4.16 Check Binary Signatures 12

1.4.17 Change the Platform Manager Service User Account 12

1.4.18 Modify permissions of SQL Server user if desired 13

1.4.19 User Creation and Management 13

1.4.20 Use SQL Server Installed with TLS 13

1.5 Intel® EMA Installed Components 14

1.6 Important File and Directory Locations 15

1.7 Scaling Considerations 15



2 Installing or Updating the Intel® EMA Server 17

2.1 Special Considerations for Installing All Components on One Machine 19

2.2 Installing Using the Setup Wizard 19

2.2.1 Initial Server Installation 19

2.2.1.1 Server Host Configuration 20

2.2.1.2 Database Settings 21

2.2.1.3 Load Balancer Information 23

2.2.1.4 Server Components to Deploy 25

2.2.1.5 Platform Manager Configuration 25

2.2.1.6 User Authentication 25

2.2.1.6.1 Local Accounts 26

2.2.1.6.2 Domain Authentication 26

2.2.1.6.3 Azure Active Directory Authentication 27

2.2.1.7 Global Administrator Account Setup 27

2.2.1.8 Finishing Up 27

2.2.1.9 Summary 28

2.2.1.10 Create Shared Folder 28

2.2.1.11 Modify IIS Settings If Ajax and Web Server Components Installed 29

2.2.1.12 Modify Server Settings for Azure AD 29

2.2.2 Additional Server Installation 29

2.2.2.1 Database Settings 30

2.2.2.2 Server Components to Deploy 32

2.2.2.3 Save the Server Settings Certificate Signing Request 33

2.2.2.4 Obtain Server Setting Certificate 33

2.2.2.4.1 Create Server Settings Certificate on Initial Distributed Server Machine 33

2.2.2.5 Upload Server Setting Certificate 34

2.2.2.6 Platform Manager Configuration 34

2.2.2.7 Summary 35

2.2.2.8 Modify IIS Settings If Ajax and Web Server Components Installed 35

2.2.2.9 Modify Server Settings 35

2.3 Performing an Update Installation Using the Setup Wizard 36

2.3.1 Database Settings 38

2.3.2 Load Balancer Information 39

2.3.3 Server Components to Deploy 39

2.3.4 Platform Manager Configuration 40

2.3.5 Summary 40

2.4 Installing or Updating Using the Command Line 40

2.4.1 Initial Installation 41



2.4.2 Add an Additional Server 43

2.4.3 Performing an Update Installation Using the Command Line 44

2.4.4 Converting to Azure AD Using the Command Line 46

2.5 Uninstalling 47

2.5.1 Uninstalling Using the Installer GUI 47

2.5.2 Uninstalling Using the Command Line 47

2.6 Intel® EMA Installer Advanced Mode Menu Bar 48

3 Using the Global Administrator Interface 51

3.1 Changing the Global Administrator Password 51

3.2 Creating and Deleting Tenants 51

3.3 Managing Users and User Groups 51

3.3.1 Adding, Modifying, and Deleting User Groups 51

3.3.2 Adding, Modifying, and Deleting Users 52

4 Performing Intel® EMA Server Maintenance 53

4.1 Manually Installing Platform Manager 53

4.2 Configuring the Intel® EMA Platform Manager Service 53

4.2.1 Platform Manager TLS Certificate 53

4.2.2 Mutual TLS Certificate for Client Authentication 53

4.2.3 Kerberos with Active Directory in a Distributed Server Installation 54

4.3 Using the Intel® EMA Platform Manager Client Application 54

4.3.1 Starting Intel EMA Platform Manager 54

4.3.1.1 From the Intel EMA Installer 54

4.3.1.2 From Windows 54

4.3.2 The File Menu 55

4.3.3 Monitoring Component Server Events 56

4.3.4 Monitoring Component Server Internal Tracking Information 56

4.3.5 Performing Basic Controls on Component Servers 56

4.4 Deploying New Packages 58

4.5 Updating the Database Connection String 59

4.6 Revoking a Server's Certificate 59

4.7 Periodic Database Maintenance 60

4.8 Restoring the Intel® EMA Server from Backup 60

5 Appendix: Troubleshooting After Installation 63

5.1 General Troubleshooting 63

5.2 Distributed Server Installation Troubleshooting 68

6 Appendix - Modifying Component Server Settings 70

6.1 Swarm Server 70

6.2 Ajax Server 71



6.3 Manageability Server 72

6.4 Web Server 74

6.5 Security Settings 76

6.6 Recovery Server Settings 78

7 Appendix – Domain/Windows Authentication Setup 80

7.1 Server Connection Information Set at Installation 80

7.2 IIS Website’s Authentication and .NET Authorization 80

7.3 Optional – Grant Permission to Website Content 80

7.4 Optional – Double-hop Structure 80

7.5 References 80

8 Appendix – Configuring 802.1X for Active Directory 81

8.1 Active Directory Domain Services 81

8.2 Active Directory Certificate Services 82

9 Appendix - Updating a Single Server Architecture Environment 84

9.1 Updating Using the Setup Wizard 84

9.1.1 Database Settings 85

9.1.2 Platform Manager Configuration 86

9.1.3 Summary 86

9.2 Updating Using the Command Line 86



Intel® EMA Server Installation Guide - Tuesday, November 21, 2023

1

1 Introduction
Intel® Endpoint Management Assistant (Intel® EMA) is a software application that provides an easy way to manage
Intel vPro® platform-based devices in the cloud, both inside and outside the firewall. Intel EMA is designed to make
Intel® AMT easy to configure and use so that IT can manage devices equipped with Intel vPro platform technology
without disrupting workflow. This in turn simplifies client management and can help reduce management costs for
IT organizations.

Intel EMA and its management console offer IT a sophisticated and flexible management solution by providing the
ability to remotely and securely connect Intel AMT devices over the cloud. Benefits include:

l Intel EMA can configure and use Intel AMT on Intel vPro platforms for out-of-band, hardware-level
management

l Intel EMA can manage systems using its software-based agent, while the OS is running, on non-Intel vPro®
platforms or on Intel vPro® platforms where Intel AMT is not activated

l Intel EMA can be installed on premises or in the cloud

l You can use Intel EMA’s built-in user interface or call Intel EMA functionality from APIs

This document describes the procedure to install and configure the Intel EMA server in a full production
environment, as well as how to maintain and manage the Intel EMA server after installation. It is intended for
technically competent system administrator users working with Intel EMA in the Global Administrator role.

Note: A simplified tutorial installation procedure for learning purposes is available in the Intel® EMA Quick
Start Guide.

The Global Administrator is responsible for installation, configuration, and management of the Intel EMA server as a
whole, as well as creating Tenant usage spaces within the Intel® EMA server. Other Intel EMA users, such as
Tenant Administrators and Account Managers are responsible for setting up and maintaining the users, user
groups, endpoint groups, and managed endpoint client systems for each Tenant hosted on the Intel EMA server.

Note: Key concepts such as user roles, tenants, and endpoint groups are described in detail in the Intel®
EMA Administration and Usage Guide, which also provides detailed information about the setup and main-
tenance of Intel® EMA Tenants and their managed endpoint systems.

We recommend that you read this guide carefully before performing the installation. This document provides the
installation requirements, explains the configuration parameters, and provides detailed installation steps for the
Intel® EMA server and its components.

1.1 Before You Begin
The actual installation of the Intel® EMA server and its components is fairly straightforward, as described in Section
2. However, before starting the procedure, we recommend that you take time to consider the following choices so
that you know in advance what to enter or select during the procedure.

l Ensure all prerequisites, described in Section 1.3, are met.

l Review the Security Recommendations in Section 1.4 and implement them as part of or after installing Intel
EMA.

l Review the Scaling Considerations in Section 1.7 to help you determine the right hardware to use for your
Intel EMA implementation.

l Determine the Fully Qualified Domain Name (FQDN) and/or IP Address that will be used to connect to the
Intel EMA server.

l For the SQL Server connection, decide if you want to use Windows authentication mode (recommended, for
security reasons) or SQL Authentication. If SQL Authentication, you will need to ensure the target credentials
are set up in SQL Server before installing.
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l Determine how you will want the Intel EMA website to be found via IIS and how it will process requests: by
FQDN/hostname only; using FQDN/hostname first, then IP Address; by IP Address only. For additional host-
names to work correctly, and to manage them, you must configure a DNS server or a router.

l Decide which form of authentication you plan to install Intel EMA under: Azure AD authentication, Windows
AD domain authentication mode (Kerberos), or normal account (username/password) mode, which is the
default. If you plan to use domain authentication, we suggest using the FQDN of your machine for the host-
name. You still need to make sure that other endpoints or other client web browsers can connect to the
value you entered here. If you decide to use another value, follow IT practice to set up the Service Principle
Name (SPN) after Intel EMA is installed.

l Determine the valid email address to use for the Global Administrator user.

l Intel EMA version 1.5.0 and later uses LDAPS secure ports by default (LDAPS secure port 636 and Global
Catalog port 3269). Previous versions of Intel EMA used the standard non-secure LDAP ports (LDAP port
389 and Global Catalog port 3268). If you are installing Intel EMA v 1.5.0 or later, and are using Active
Directory or 802.1x integration, ensure the LDAPS ports are enabled. If you prefer to use the standard non-
secure ports, then after installing Intel EMA, open the installer program again (EMAServerInstaller.exe, run
as administrator) and select File > Advanced Mode, then click Settings > Switch from LDAPs to LDAP to
reset the LDAP ports Intel EMA uses to the standard non-secure ports. Alternatively, you can change the
ports in the Web server settings on the Server Settings page in the Intel EMA UI. If you experience problems
with 802.1x setup during Intel AMT provisioning, this could be the issue. See the following link for more
information: https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-
domains-and-trusts.

1.2 Supported Operating Systems
As a stand-alone application, the Intel® EMA Agent can be installed on the following operating systems:

l Microsoft Windows 10

l Microsoft Windows 11

Intel EMA Server can be installed on the following operating systems:

l Microsoft Windows Server 2019 (Note: The getPFX API requires the Intel EMA server to be installed on Win-
dows Server 2019 or later)

l Microsoft Windows Server 2022 (Note: Crypto for Intel ME 11 systems is disabled by default on Windows
Server 2022)

1.3 Installation Prerequisites
This is a list of the prerequisites needed to set up the Intel® EMA Server.

1.3.1 Computer
A computer or virtual machine with sufficient capability for the expected traffic. Systems not meeting these minimum
specifications could experience performance issues.

2 Intel® Xeon® Processors, 16 threads, 24GB RAM, 1TB Mirrored: This configuration should be able to handle over
20k connections.

For scaling considerations pertaining to large and/or distributed installation environments, see section 1.7.

1.3.2 Operating System
See Supported Operating Systems, section 1.2.

Currently, Intel EMA does not provide internationalization support. The operating system needs to have English-US
Windows display language, English-US system locale, and English-US format (match Windows display language).

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
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1.3.3 Database
Install the Microsoft SQL Server*. The database may run on a separate server on the network or on the same
system as the Intel EMA Server. For demonstration or test purposes, Microsoft SQL Server Express edition can be
used if installed with Advanced Features. For production environments, we recommend using Microsoft SQL Server
Enterprise. A strong working knowledge of installing, configuring, and using SQL and Active Directory is required (if
using 802.1x).

IMPORTANT: To achieve security in-depth, we recommend to use Microsoft SQL Server Enterprise and
enable Transparent Data Encryption. Additionally Windows authentication mode is recommended as the
authentication mode.

Notes:

l Microsoft SQL Server 2017, 2019, and 2022 (English-US version only) are supported.

l The operating system of the machine on which SQL Server is running must be a supported operating
system version and needs to have English-US Windows display language, English-US system loc-
ale, and English-US format (match Windows display language). See Supported Operating Systems,
section 1.2.

l The collation value in SQL Server must be set to SQL_Latin1_General_CP1_CI_AS.

l Be sure to allocate enough resources (CPU, memory, SSD, etc.) to SQL Server. If your SQL Server's
resources are dynamically allocated, ensure enough guaranteed fixed resources are allocated. If not,
you may see error messages like "Unable to get database connection, all connections are busy" in
the component server log files in Program Files (x86)\Intel\Platform Manager\EmaLogs.

l Intel EMA uses query notification in SQL Server to reduce the number of database reads. That fea-
ture requires "Service Broker" to be enabled in SQL server. If Service Broker is disabled, you will see
warnings to that effect in the component server log files in Program Files (x86)\Intel\Platform Man-
ager\EmaLogs.

l If you choose SQL authentication during installation you will be required to supply two database
connection strings. One string is for a more permissive account used to install the database, and the
other is for less permissive account used by Intel EMA services to access the database after
installation.

l Before installing Intel EMA, ensure that an account exists on the SQL server that can be used by the
Intel EMA installer to connect to the SQL server and create the Intel EMA database. If you are not the
SQL database administrator (SQL DBA), contact the SQL DBA to have this account set up. This
account must exist before you install Intel EMA, since you will be asked to specify the
SQL connection account during the installation process. This account may be a Windows account
under Windows Authentication or an SQL account under SQL Authentication. In addition, the
SQL account must have a default database configured. The default database can be any existing
database on the SQL server. This default database is required so that the Intel EMA installer can con-
firm that the specified SQL account/user can contact the SQL server and its databases.

l Before installing Intel EMA, ensure that the SQL account used in the Intel EMA SQL connection string
to create the database has sysadmin rights (to create new account for IIS default application pool
identity) and has at least dbcreator permission, which allows it to create, modify, and delete any data-
base. Also, this account must have the database level roles db_owner, db_datawriter, and db_
datareader. The “sysadmin” right is needed in order to create the new user “IIS APPPOOL\\De-
faultAppPool\” for the SQL server (if it does not exist). If it exists already or you do not use that
account for the IIS application pool of the Intel EMA website, then the role needed during installation
is “dbcreator”, to create the Intel EMA database. Keep in mind that the “sysadmin” or “dbcreator”

IMPORTANT: If you do not grant "sysadmin" rights to the SQL connection account, the install-
ation will still complete successfully, but with errors related to not being able to create the IIS
APPPOOL user mentioned above. If you did not grant "sysadmin" rights to the
SQL connection account, you MUST manually create this user on the SQL server after the
installation completes in order for Intel EMA to work.
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See Section 1.4.18 for information about changing these permissions and roles.

1.3.4 Pre-installation Instructions for Microsoft Azure AD
Environments
If you plan to install Intel EMA in an existing Microsoft Azure AD environment, follow the steps below in order to
enable Intel EMA to successfully connect to the Azure AD environment. We recommend that you perform these
steps before installing Intel EMA, however they can be performed after installation, though you will not be able to
add users and perform other Intel EMA actions until you perform these steps in Azure AD.

Note: Intel EMA instances configured to use Azure AD authentication do not support individual user authen-
tication via the REST API from scripts or outside applications. Use of Client Credential authentication is a
supported alternative on these instances. If you require the use of integrating applications or administrative
scripts that call Intel EMA’s APIs, verify that they will work with Azure AD authentication before proceeding
with a production deployment.

1. In your Azure AD tenant (note that this is NOT the same as an Intel EMA tenant), create a new app regis-
tration. This app will be associated with Intel EMA once Intel EMA is installed, and Intel EMA will use this
app to interact with Azure AD to exchange information.

a. Got to Azure Active Directory > App Registration and create anew app registration.

b. Supported account types for the new app must be Accounts in this organizational directory only.

c. Configure the Redirect URI, choosing Web as the Platform.

d. Enter https://<EMA FQDN or IP>/api/latest/azureLogin as the Redirect URI value (note
that this URI is case sensitive).

2. In the Certificates & Secrets section for the newly registered app, add a new client secret:
a. At the time of client secret creation, record the client secret's value, as it is only displayed once. You

will need this value later when you configure Intel EMA's Web Server settings after installation. Be
sure to secure this sensiteve information.

b. Consider the expiration date for the client secret. Note that before it expires, you will need to create a
new client secret and update the Web Server settings in Intel EMA.

3. In the API permissions section for the newly registered app, add the required permissions:
a. Ensure that a "Delegated" permission type for Microsoft Graph with “User.Read” permission exists.

b. Add a permission for Microsoft Graph with “Application” Type and with "User.Read.All" permission.

c. Click to Grant admin consent for these API permissions.

4. Go to the Overview section of the newly registered app and copy/record the Azure AD Directory (tenant) ID,
the Azure AD Application (client) ID, to go with the Azure AD Client Secret Value you created above. Use
these values to configure the Intel EMA Web Server after initial server installation, as described in Section
2.2.1.12.

1.3.5 Web Server
Intel EMA uses Microsoft Internet Information Server (IIS). Use the latest IIS 10 version.

Install IIS URL Rewrite Module for the target IIS. If it is installed, Intel EMA will set up the website setting to remove
the IIS server version from the response header. Further, the rewrite module will add the HSTS header, the cookie
Same Site strict, and the auto redirect from HTTP to HTTPS. If it is not installed, these settings will not be applied.

Note: If IIS is already installed, ensure that all authentication methods are disabled except for “Anonymous”
and “Windows” (only those two should be enabled). This only applies to Windows Authentication mode.
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1.3.6 Intel® AMT PKI Certificate
Intel AMT Admin Control Mode (ACM) provisioning requires a certificate issued by a trusted authority that matches
the domain name of the target Intel AMT endpoints. The certificate file needs to have the full certificate chain. Also, it
needs to be issued with the supported OID 2.16.840.1.113741.1.2.3 (this is the unique Intel AMT OID).

Note: Starting with Intel ME 15 systems support for SHA1 root certificates or RSA key sizes smaller than
2048 in Intel AMT PKI Certificate chain was removed.

1.3.7 Microsoft .NET Framework Versions
Intel EMA Server software is built with Microsoft .NET Framework 4.8. The operating system must have Microsoft
.NET Framework 4.8 or later. If .NET Framework 4.8 or later is not installed, the Intel EMA installer will display a
dialog prompting you to download and install .NET Framework 4.8 runtime.

1.3.8 Firewall
We recommended using a firewall software to ensure that only authorized ports are available for connection. The
firewall software built into Windows can perform this task.

1.3.9 Network
During the installation, you must specify the value (either hostname or IP address) to use for communication among
various components. If you choose hostname or FQDN, you need to make sure the value is resolvable by a DNS
server in the network. If you do not have the DNS server, a fixed IP address should be used during installation.
Incorrect hostname/IP address will cause Intel EMA features to not function properly. In a distributed server
archecture implementation, if using Active Directory, ensure all computers (including the computer hosting the load
balancer) are listed in Active Directory.

FQDN and/or IP addresses selected are used for various purposes:

l Swarm Server Load Balancer FQDN/IP address is the location that will be provided in the agent con-
figuration file for endpoint agents, Intel AMT, or Intel® Standard Manageability to connect to.

l Ajax & Web Server Load Balancer FQDN/IP address is used for the main Intel EMA website HTTPS URL.

l Recovery Server Load Balancer FQDN/IP address is used to support One Click Recovery.

These settings CANNOT be changed after installation. Make sure each resolves correctly in DNS, and consider
choosing a FQDN that can be flexibly reconfigured to a different server when needed – for example, a dynamic DNS
entry.

1.3.10 Network Ports
Table 1 lists the server network ports used for various communications among server components.

l For certain features/usages, the AJAX server and Manageability server will establish a TCP connection (loc-
ally or remotely) with the Swarm server.
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l The endpoint and the Swarm server communicate via a secure TCP connection. Intel AMT (CIRA) and the
Swarm server communicate via a secure TCP connection.

l The Platform Manager service uses a named pipe to talk to other Intel EMA component servers on the same
machine. The Platform Manager client application talks to the Platform Manager service via a secure TCP
connection.

Table 1: Server network ports

Protocol Port Usage
TCP 443 HTTPS Web server port. This is used between the web browser and

the web server.

TCP 1433 SQL server remote access. This is used between the internal Intel
EMA server and the internal SQL server; only needed if Intel EMA
server and the SQL server are not on the same machine. This is the
default port that SQL server uses.

TCP 8000 The default TCP port for communication between Platform Manager
service and Platform Manager client. You can change this port during
installation.

TCP 8080† Agent, console, and Intel AMT CIRA port. This is between client end-
points and the Intel EMA Swarm server. See note below.

TCP 8084 Web redirection port. This is used between the web browser and the
web server.

TCP 8085 Recovery port. This is used by the Recovery component server. If you
change this port on the Recovery Server tab of the Server Settings
page, you will be prompted to update port bindings. See "Appendix -
Modifying Component Server Settings" on page 70.

TCP 8089 Communication between the various Intel EMA component servers
and Intel EMA Swarm server. This port number is the default, and can
be changed in the Server Settings page. See "Appendix - Modifying
Component Server Settings" on page 70.

TCP 8092 Port on which Ajax component server listens for internal component-
to-component communication. This port number is the default, and
can be changed in the Server Settings page. See "Appendix - Modi-
fying Component Server Settings" on page 70.

TCP 8093 Port on which Swarm component server listens for internal com-
ponent-to-component communication. This port number is the default,
and can be changed in the Server Settingspage. See "Appendix -
Modifying Component Server Settings" on page 70.

TCP 8094 Port on which Manageability component server listens for internal
component-to-component communication. This port number is the
default, and can be changed in the Server Settings page. See
"Appendix - Modifying Component Server Settings" on page 70.

TCP 8095 Port on which Recovery component server listens for internal com-
ponent-to-component communication. This port number is the default,
and can be changed in the Server Settings page. See "Appendix -
Modifying Component Server Settings" on page 70

LDAPS/LDAP 636/389 The LDAPS secure port is 636. The standard non-secure LDAP port
is 389. These ports are for use with Active Directory and/or 802.1x
configuration.

Global Catalog
(secure/non-

3269/3268 The secure (3269) and non-secure (3268) Global Catalog ports.
These ports are for use with Active Directory and/or 802.1x con-
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secure) figuration.

†You can change the port that the agent and Intel AMT CIRA use to connect to the Intel EMA server.

1. On the load balancer, create a forwarding rule to route the desired port (for example, 8081) to the backend
Swarm server port 8080. Note that the Swarm server is still listening on port 8080, but this allows you to set
a different port for your external facing network.

2. On the Manageability server, change server settings ciraserver_port from 8080 to the desired port (i.e., 8081
in this example). Halt and restart the Manageability server. See "Appendix - Modifying Component Server
Settings" on page 70 for information about changing settings for Intel EMA component servers.

3. For web server settings, change server settings SwarmServerPort from 8080 to desired port. Sync the IIS
app setting with this change. See "Appendix - Modifying Component Server Settings" on page 70 for inform-
ation about changing settings for Intel EMA component servers.

4. Create a new endpoint group (note that the existing endpoint group will not have the new SwarmServerPort
information) and register an endpoint to this new endpoint group. Then provision Intel AMT on the endpoint.
See the Intel® EMA Administration and Usage Guide for information about endpoint groups and provisining
Intel AMT on endpoints.

1.4 Security Recommendations
This section details the security recommendations you should take into consideration when using Intel® EMA.
Refer to industry best practices sources and your IT organization’s policies for information on how to implement
these recommendations.

Important: For distributed server architecture installations, be sure to make all applicable changes below on
all your Intel EMA servers.

1.4.1 Perform a Backup of Important Data
Intel EMA’s component servers rely on several certificates created during the Intel EMA installation time.

The installer creates a self-signed MeshRoot root certificate, which it uses to create one or more
MeshSettingsCertificates that are stored in the Local Machine\Personal certificate store. These
MeshSettingsCertificate certificates are used to encrypt/decrypt the server settings stored in the database.

The MeshRoot certificate is used to create the mutual TLS certificates (EmaMtlsXXX) for the TCP-TLS
communications between the Intel EMA component servers (Ajax, Swarm, Manageability, Recovery, Web). They
are stored in the Local Machine\Personal certificate store.

If these certificates are lost, there is no way to make Intel® EMA work again without completely reinstalling the Intel
EMA server.

Therefore, after installing the Intel EMA server (or each server in a distributed environment), it is strongly
recommended that you perform the following steps:

l Back up Intel EMA database (this should also be done periodically, not just after setup).

l Back up the MeshSettingsCertificate which is stored in the Local Machine\Personal certificate store on your
server machine. This certificate is used to encrypt/decrypt the server settings stored in the database.

1.4.2 Modify the Access Control List (ACL) for Key Configuration Files
After the Intel EMA server installation, you should modify the ACL to limit access to the following files\folders:

l [Intel EMA website root folder (e.g., C:\inetpub\wwwroot)] \ web.config.

l [Intel EMA server installation folder (e.g., C:\Program Files (x86)\Intel\Platform Manager)] \ Platform Manager
Server \ settings.txt
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l [Intel EMA server installation folder (e.g., C:\Program Files (x86)\Intel\Platform Manager)] \ Runtime \
MeshSettings \ connections.config

l [Intel EMA server installation folder (e.g., C:\Program Files (x86)\Intel\Platform Manager)] \ Runtime \
MeshSettings \ app.config

l [Intel EMA server installation folder (e.g., C:\Program Files (x86)\Intel\Platform Manager)] \ EMALogs

1.4.3 Enable Transparent Data Encryption on SQL Server Enterprise
To achieve security in-depth, we recommend that you use SQL Server Enterprise and enable Transparent Data
Encryption.

1.4.4 Secure all Certificates and Keys
When Intel EMA is installed, several certificates and encryption keys are generated. The certificates and encryption
keys created by Intel EMA expire after 20 years.

Certificates are stored in the Intel EMA server database and in the server machine’s certificate store. Take care to
keep these certificates secure. If they are compromised, Intel EMA cannot replace them and push them to the
managed endpoints. In this case, you would need to uninstall and reinstall the Intel EMA server using new
certificates, then recreate all users and endpoint groups and then re-register all your endpoints.

Most of the encryption keys are stored in Intel EMA server settings, which is encrypted and saved in the Intel EMA
server database.

1.4.5 Samples files for Intel® EMA REST API and JavaScript library
The sample files are in the folder [Intel EMA installation package folder] \Samples. These files are not automatically
hosted on the Intel EMA website during installation. These sample files are implemented using bare-minimum code
to demonstrate how to use the API and do not use secure coding practices to guard against security concerns like
cross-site scripting.

IMPORTANT: These samples should never be hosted in a production environment.

For hosting in a test environment for development purposes, copy the Samples folder to the Intel EMA website root
folder (e.g., C:\inetpub\wwwroot\).

1.4.6 Disable Insecure Cipher Suites
Cipher suites determine the key exchange, authentication, encryption, and algorithms used in an SSL/TLS session.

It is strongly recommended that you disable insecure cipher suites to restrict the use of weak cryptographic
algorithms and protocols for TLS connections.

By default, many versions of Microsoft Windows Server may have an insecure cipher suite configuration. The
following are the warnings or threats that result from insecure ciphers:

l 64-bit block cipher 3DES vulnerable to SWEEET32 attack

l Broken cipher RC4 is deprecated by RFC 7465

l CBC-mode cipher in SSLv3 (CVE-2014-3566) – Oracle padding

l Cipher suite uses MD5 for message integrity

l Weak certificate signature for SHA1

l Key exchange (DH 1024) is of lower strength than the certificate key

One workaround to avoid these threats and warnings is to download IIScrypto from this website:
https://www.nartac.com/Products/IIScrypto. This product helps to change schannels and cipher settings.

https://www.nartac.com/Products/IIScrypto
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You must run the IIScrypto program and de-select the multi-protocols: unified hello, PCT 1.0, SSL2.0, MD5, and all
ciphers above triple DES. This helps clear all the aforementioned warnings (except for the SHA1 warning).

IMPORTANT! Intel EMA and Intel AMT require one of the following Cipher Suites to be enabled in order to
effectively communicate and function. As an example, enabling “TLS_RSA_WITH_AES_128_GCM_
SHA256” would work for all versions of Intel AMT currently supported by Intel EMA.

l Intel AMT version 11.8:
l TLS_RSA_WITH_AES_128_GCM_SHA256

l TLS_RSA_WITH_AES_256_CBC_SHA

l TLS_RSA_WITH_AES_128_CBC_SHA

l Intel AMT version 12:
l TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

l TLS_RSA_WITH_AES_128_GCM_SHA256

l TLS_RSA_WITH_AES_256_CBC_SHA

l TLS_RSA_WITH_AES_128_CBC_SHA

l Intel AMT versions 14 and 15:
l TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

l TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

l TLS_DHE_RSA_WITH_AES_256_GCM_SHA384

l TLS_RSA_WITH_AES_128_GCM_SHA256

l TLS_RSA_WITH_AES_256_CBC_SHA

l TLS_RSA_WITH_AES_128_CBC_SHA

l Intel AMT version 16:
l TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

l TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

l TLS_DHE_RSA_WITH_AES_256_GCM_SHA384

l TLS_RSA_WITH_AES_128_GCM_SHA256

l .

1.4.7 Strong Encryption Protocols
We strongly recommend that you disable weak encryption protocols, such as PCT 1.0, SSL 2.0, SSL 3.0, TLS 1.0,
and TLS 1.1, and instead enable strong encryption protocols, such as TLS 1.2 and TLS 1.3. Additionally, we
recommend that you use the Diffie-Hellman Ephemeral (DHE) protocol.

Note: Intel EMA will not support Intel AMT versions below 11.8.77.3664, as those versions use TLS 1.1
which is no longer supported in Intel EMA.

1.4.8 IIS – Replace the Temporary Web TLS Certificate
The Web TLS certificate is used for HTTPS communications between the Web browser and the Web + AJAX Server.
A temporary self-signed Web TLS certificate is created during installation. This certificate can be replaced at any
time. We recommend that you use a valid HTTPS certificate issued from a valid trusted Certificate Authority.

Note:

l This TLS certificate can also be used for the Platform Manager TLS certificate if you are running Plat-
form Manager on the same system as the IIS server. See section 4.2.

l For the self-signed website TLS certificate (and the Intel EMA settings certificate), Intel EMA grants
the default IIS DefaultAppPool account read access to the private key. If you change the account that
the IIS default application pool will run under, you must also change the access control accordingly.
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To replace the temp Web TLS Certificate:

1. Install the new certificate in the Local Machine\Personal certificate store.

2. Run the IIS Manager on the Web Server (IIS Server).

3. Place the certificate in the Server Certificates.

4. Edit the Bindings section in the Default Website dialog box to use the new certificate.

1.4.9 IIS – Change IIS User Account
By default, Intel EMA uses the IIS default application pool (app pool) to run the Intel EMA website. This default app
pool uses the ApplicationPoolIdentity account by default. In a distributed installation running under Windows
authentication, where the Intel EMA component servers need to access a remote SQL Server, you may need to
change the account the Intel EMA website runs under to one that can access the remote SQL Server.

To do this, follow the steps below:

1. Give the account access to Intel EMA assets (files and folders, certificate's private key).
1. Skip these steps if the account already has the necessary privileges.

2. If the SQL connection is using Windows authentication, ensure the new IIS user account satisfies the
permission and role requirements for the SQL Server account. See section 1.4.18.

3. Change the service to run under the desired account.

4. Give read and write access to [System drive]\Program Files (x86)\Intel\Platform
Manager\EMALogs.

5. Give full control to the following:
l [System drive]\inetpub\wwwroot: also for all sub-folders and files.

l [System drive]\inetpub\wwwroot\web.config

l [System drive]\Program Files (x86)\Intel\Platform Man-
ager\Runtime\MeshSettings\app.config

l [System drive]\Program Files (x86)\Intel\Platform Man-
ager\Runtime\MeshSettings\connections.config

6. Use the Windows certlm tool to open the certificate store for Local Computer\Personal\Certificates
and give "read" permission for the following certificates by right-clicking the target certificate and
selecting All Tasks\Manage Private Keys:

l Temporary Web TLS certificate. "Issued To" is the Intel EMA web site FQDN or IP. "Issued By"
is "MeshRoot-XXXX".

l Settings certificate. "Issued To" is "MeshSettingsCertificates-XXX". "Issued By" is "MeshRoot-
XXXX".

l Inter-component TLS certificate for web server. "Issued To" is "EmaMtlsWeb-XXX". "Issued
By" is "MeshRoot-XXXX".

2. Add a new IIS application pool for Intel EMA.
1. Use IIS Manager to create a new app pool.

2. Choose .NET CLR Version v4.0.XXX, Integrated pipeline mode, and Start app pool immediately.

3. Assign an account to the new application pool.
1. Use IIS Manager to change the account for the new app pool.

2. Choose Custom Account and specify the desired Windows account.

4. Use IIS Manager to change the application pool used by Intel EMA to the new one created above. Then
restart the whole web site. For verification, access the Intel EMA web site in a browser, then use Windows
Task Manager to verfiy that the w3wp.exe process is running under the specified account.

1.4.10 IIS – Enabling the Transport Layer Security Protocol
It is strongly recommended that you enable Transport Layer Security (TLS), which is an industry-standard protocol
designed to protect the privacy of information communicated over the internet.
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The TLS protocol enables clients/server applications to detect these security risks:

l Message tampering

l Message interception

l Message forgery

HTTP Strict Transport Security (HSTS) is an opt-in security enhancement policy, which must be enabled to ensure
connections can only be successful if the Transport Layer Security (TLS) protocol is used.

1.4.11 IIS – Machine Key Validation Method
The machine key element in the ASP.NET web.config specifies the algorithm and keys to be used by an application
for encryption and hashing. Ensure that one of the SHA-2 family methods (for example, HMACSHA256) is
configured as the validation method for the machine key.

1.4.12 IIS – Restrict Unlisted IIS Extensions Execution
If IIS features ISAPI Extensions or CGI are installed, ensure that unspecified ISAPI modules or unspecified CGI
modules, respectively, are not allowed to run.

1.4.13 IIS – Dynamic IP Address Restrictions
For distributed server architecture installations, consult your load balancer documentation to enable protection to
deny an IP Address based on the number of concurrent requests and deny an IP Address based on the number of
requests over a period of time.

1.4.14 IIS – Configure Host Headers for All Sites
If multiple websites will be hosted in IIS on the same IP address and port, configure host headers for all sites.

1.4.15 IIS - Review updated web.config File
The Intel® EMA server installation adds the following headers to your web.config file, and renames the existing
web.config file to web.config.original.<date>. After installation, review the new web.config file and modify if desired.

For more information about HTTP headers, refer to the following link:

https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers

The following headers are automatically added to the web.config file during installation.

Table 2: Headers added to web.config

Header Value
X-Content-Type-Options nosniff

X-XSS-Protection 1; mode=block

X-Frame-Options SAMEORIGIN

Referrer-Policy strict-origin

Expect-CT max-age=86400, enforce

Feature-Policy payment 'none'; microphone 'none'; geolocation 'none';

strict-transport-security

Note: Added by IIS rewriter rule

max-age=31536000; includeSubDomains;

Content Security Policy (CSP)

Note: Added by plugin

default-src 'self' blob:;script-src 'self' 'unsafe-inline'
'nonce-<autogen_value> ' 'sha256-<multiple values> ';
object-src 'none';style-src 'self' 'unsafe-inline'

https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers
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https://fonts.googleapis.com;img-src 'self' data:;
font-src 'self' data: https://fonts.gstatic.com;base-uri
'none';worker-src 'self' blob:

The CORS header is added but commented out by default. To enable it, edit the web.config file and remove the
comment tags and add your domain information.

<!--

<add name="Access-Control-Allow-Origin" value="https://<YOURDOMAINHERE>" />

<add name="Access-Control-Allow-Headers" value="Content-Type" />

<add name="Access-Control-Allow-Methods" value="GET,POST,PUT,DELETE,OPTIONS"
/>

-->

Lastly, the X-Robots-Tag header is added, which disables web search engines from finding installed instances of
the Intel® EMA server.

Note: Intel EMA grants the default IIS DefaultAppPool account read access to the web.config file. If you
change the account that the IIS default application pool will run under, you must also change the access con-
trol accordingly.

1.4.16 Check Binary Signatures
All Intel EMA binaries are signed as an integrity mechanism. We recommend that you check and confirm the
signatures on these files. Further, we recommend that you only use installation packages from trusted sources
(such as www.intel.com).

1.4.17 Change the Platform Manager Service User Account
Perform this action after installing the Intel EMA server. By default, the Intel EMA Platform Manager service runs
under the System user. To improve security, we recommend that you modify this service to run as a local or domain
user.

Notes:

l Whatever account you set Platform Manager to run under will be the account that all Intel
EMA component server services (i.e., Manageability Server, Swarm Server, etc.) run under as well.
After the Platform Manager account is changed, the component server services will use the new
account once they are restarted. In a distributed server environment this must be done for each
Platform Manager instance.

l The account that Platform Manager runs under needs to have correct permissions to perform
deployment and management of IIS websites. For further information, see
https://learn.microsoft.com/en-us/troubleshoot/developer/webapps/iis/www-authentication-
authorization/default-permissions-user-rights.

First, give the account access to Intel EMA assets (files and folders, certificate's private key).

1. Skip these steps if the account already has the necessary privileges.

2. If the SQL connection is using Windows authentication, ensure the new user account satisfies the per-
mission and role requirements for the SQL Server account. See section 1.4.18.

3. Change the service to run under the desired account.

4. Give read and write access to [System drive]\Program Files (x86)\Intel\Platform Manager\EMALogs.

http://www.intel.com/
https://learn.microsoft.com/en-us/troubleshoot/developer/webapps/iis/www-authentication-authorization/default-permissions-user-rights
https://learn.microsoft.com/en-us/troubleshoot/developer/webapps/iis/www-authentication-authorization/default-permissions-user-rights
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5. Give full control to the following:
l [System drive]\inetpub\wwwroot: also for all sub-folders and files.

l [System drive]\inetpub\wwwroot\web.config

l [System drive]\Program Files (x86)\Intel\Platform Manager

l [System drive]\Program Files (x86)\Intel\Platform Manager\Runtime\MeshSettings\app.config

l [System drive]\Program Files (x86)\Intel\Platform Man-
ager\Runtime\MeshSettings\connections.config

6. Use the Windows certlm tool to open the certificate store for Local Computer\Personal\Certificates and give
"read" permission for the following certificates by right-clicking the target certificate and selecting All
Tasks\Manage Private Keys:

l Temporary Web TLS certificate. "Issued To" is the Intel EMA web site FQDN or IP. "Issued By" is
"MeshRoot-XXXX".

l Recovery certificate. "Issued To" is the Intel EMA web site FQDN or IP. "Issued By" is "MeshRoot-
XXXX".

l Settings certificate. "Issued To" is "MeshSettingsCertificates-XXX". "Issued By" is "MeshRoot-XXXX".

l Inter-component TLS certificate for web server. "Issued To" is "EmaMtlsWeb-XXX". "Issued By" is
"MeshRoot-XXXX".

l Note that the Temporary Web TLS certificate and the Recovery certificate look similar in the listing,
but if you open them and go to the Details tab, you can see which is which.

Next, ensure the file settings.txt in the Intel EMA installation folder has read/write permissions for the new Platform
Manager service account.

Lastly, find Intel Platform Manager in Windows services and change the user account under which this service is
running, then restart all the Intel EMA component servers.

1.4.18 Modify permissions of SQL Server user if desired

Note: Two database accounts are required when using SQL authentication: one of the installer which
requires DB Owner permissions, and one for the Intel EMA services, which allows the database service to be
run with lesser privileges.

The first account, for the installer, needs db_owner, db_datawriter, and db_datareader permissions to create the
Intel EMA database during installation. These permissions are granted by default during Intel EMA installation.

The second account you specify during installation requires Execute permission to run all Intel EMA stored
procedures.

Also, you must grant permission for "SUBSCRIBE QUERY NOTIFICATIONS" to the user of Intel EMA database.

1.4.19 User Creation and Management
It is strongly recommended that you periodically check existing user accounts for Intel EMA and ensure that any
accounts that are no longer being used are deleted. See the Intel® EMA Administration and Usage Guide for
information on creating, modifying, and deleting user accounts.

1.4.20 Use SQL Server Installed with TLS
It is strongly recommended that you use an instance of SQL Server that has been installed with TLS to encrypt data
transmitted between SQL Server and Intel EMA. For more information, see the link below:

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-
database-engine?view=sql-server-ver15

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
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1.5 Intel® EMA Installed Components
After installation, most software components are installed in the C:\Program Files (x86)\Intel\Platform Manager
folder. The main components are as follows:

l Intel® EMA Platform Manager service:
l Installed as an auto-started Windows service with display name Intel® EMA Platform Manager and
service name PlatformManager

l Deploys the Intel EMA website content to the IIS server

l Monitors Intel EMA component servers on the machine and auto-starts any that are not running

l In a distributed server architecture, each Intel EMA server machine will have its own Platform Man-
ager service

l Intel EMA Platform Manager client application:
l Installed as a Windows desktop application

l Provides the graphical user interface (GUI) for user interaction

l Used for checking Intel EMA internal server events and performing simple server controls

l Can communicates with the Platform Manager service on a local or remote machine

l Intel EMA website:
l Primary GUI for end users

l Deployed on the IIS server by the Platform Manager service after installation

l May have multiple instances in a distributed environment

l See the Intel® EMA Administration and Usage Guide for further details

l Intel EMA REST APIs:
l Deployed on the IIS server by the Platform Manager service after installation

l Enables third-party software development to create a different Intel® EMA GUI for end users

l See the Intel® EMA API Guide for further details

l Intel EMA JavaScript libraries:
l Deployed on the IIS server by the Platform Manager service after installation

l Delivers some features that REST APIs are not designed to support

l Enables third-party software development to create a different Intel EMA GUI for end users

l See the Intel® EMA JavaScript Libraries Guide for further details

l Intel EMA AJAX server:
l Started by the Platform Manager service

l Handles the JavaScript library’s requests

l May have multiple instances in a distributed environment

l See the Intel® EMA Administration and Usage Guide for further details about the scheduled tasks
feature

l Intel EMA Swarm server:
l Started by the Platform Manager service

l Accepts the TCP connection from the endpoints (devices) and handles communication between end-
points

l May have multiple instances in a distributed environment

l Intel EMA Manageability server:
l Started by the Platform Manager service

l Manages Intel AMT provisioning and unprovisioning requests for endpoints

l Talks to the Swarm server to send provision/unprovision requests to the endpoints

l Only one instance in a distributed environment
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l Intel EMA Recovery Server
l Started by the Platform Manager service

l Used for initiating recovery process to return specified endpoint’s OS to a last known good state in a
secure manner

l May have multiple instances in a distributed environment

l Intel EMA Agent:
l Agent software is not installed on the server machine

l Agent installer is included in Intel EMA software package

l Agent must be installed on the endpoint for the Intel EMA server to manage it

l See the Intel® EMA Administration and Usage Guide for how to download and manage the agent
installers

1.6 Important File and Directory Locations
<Installer Directory>/EMALog-Intel®EMAInstaller.txt Installation log

C:\Program Files (x86)\Intel\Platform
Manager\Platform Manager Server\settings.txt

Contains settings for the Platform Manager, including the port
number and password.

C:\Program Files (x86)\Intel\Platform Man-
ager\Runtime\MeshSettings\app.config and con-
nections.config

Contains the database connection string (encrypted).

C:\Program Files (x86)\Intel\Platform
Manager\EMALogs

l EMALog-XXX.txt

l TraceLog-XXX.txt

A log for each server component. These are the same log
messages that you can see in the Platform Manager’s Event
log.

C:\Program Files\Intel\Ema Agent Install location for 64 bit Intel EMA Agent files.

C:\inetpub\wwwroot IIS web site locations.

1.7 Scaling Considerations
As you plan your Intel EMA server implementation, keep in mind that the configuration of the server hardware can
have an impact on the overall performance of your Intel EMA instance as the number of managed endpoints grows.
The following tables show testing results that may be helpful in determining the appropriate server hardware
configuration for your Intel EMA server installation. The tables show the number of managed endpoints required to
achieve maximum capacity in the DB (DB 100% CPU ) then next to it shows the average CPU capacity on Intel
EMA servers when it hit max load on DB given the server and database hardware configurations in the row labels
(e.g., 4 CPUs and 16 GB memory).

Note: Performance can vary greatly from one implementation to another depending on a variety of envir-
onmental factors. The following test result information is provided solely to aid in pre-implementation
decision making and is not intended as any claim of actual performance.

Based on the following test result data, for example, you could expect a single Intel EMA server with 2 CPUs and 8
GB of RAM to satisfactorily support approximately 79K managed endpoints (the DB 80% CPU column below). Note
that if CIRA will be used, we recommend that you reduce the number of endpoints in any column below by half.
Furthermore, the data below is based on an idle state for the Intel EMA agent on the managed endpoint. You
should allow some headroom (for example, 20%) for usage such as KVM sessions on the endpoint.

Given the above considerations, for a single Intel EMA server with 2 CPUs and 8 GB of RAM and using a database
with 4 CPUs and 16 GB of RAM in an implementation where CIRA will be used, we recommend no more than
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approximately 31K managed endpoints (79K/2 * .80 = 31.6). Note also that in a multi-server configuration, adding
additional servers does not necessarily increase linearly the number of managed endpoints as there is an overload
on the database.

Table 3: Single Server Load

Intel EMA Server
Configuration

Intel EMA % CPU DB
80% CPU

Intel
EMA %
CPU

DB
100% CPU

DB Configuration

2 CPU, 8 GB memory ~50% ~79K ~65% ~96K 4 CPU, 16 GIG
Memory

8 CPU, 32 GB memory ~24% ~80K ~30% ~100K 8 CPU, 32 GIG
Memory

Table 4: Multi-Server Load

Number of Intel EMA Servers
(8 CPU, 32 GB memory

Intel EMA % CPU DB
80% CPU

Intel
EMA %
CPU

DB
100% CPU

DB Configuration

2 ~24% ~160K ~30K ~200K 8 CPU, 32GB
Memory

3 ~24% ~240K ~30K ~300K 8 CPU, 32GB
Memory

4 ~20% ~276K ~25% ~345K 8 CPU, 32GB
Memory
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2 Installing or Updating the Intel® EMA
Server
Follow the steps below to install the Intel® EMA server in a distributed architecture installation. For updating, see
section 2.3.

General Installation Notes:

l If you plan to use Azure AD authentication, you must follow the pre-installation steps in Azure AD as
described in section 1.3.4.

l Do not edit the Intel EMA database to manually add a user to the user table. Use the Intel EMA user
interface (either GUI or API) to create all Intel EMA user accounts.

l Installing two separate Intel EMA instances that use the same Intel EMA database is not supported.
Note that this is different from a distributed server architecture installation in which an Intel
EMA instance's server components are installed on multiple machines.

l Having multiple instances of the Manageability Server component server running is not supported.
However, installing a second instance of the Manageability Server for failover purposes is allowed as
long as the Manageability service on the second instance is stopped and disabled. If there are no act-
ive Manageability Servers, you will still be able to manage existing endpoints but you will not be able
to provision new endpoints or utilize the USB Redirection (USBR) feature. If needed, in a failover
scenario, this second instance can be started. When started, the Intel EMA component server settings
must be updated to point to the IP address of new Manageability Server. See section 6 for inform-
ation on modifying component server settings.

l If you are using a remote SQL database, and you do not plan to change the account under which Plat-
form Manager and the Intel EMA component servers run (note, it is recommended to change this
account, per Section 1.4.17), then before installing Intel EMA you must manually create an account
on the remote SQL database for the system account of the machine on which the Intel EMA server
will be installed.

l The USB Redirection (USBR) and One Click Recovery (OCR) features of Intel EMA allows you to
mount a remote disk image (.iso or .img) to a managed endpoint via Intel AMT. To enable these fea-
tures, you must create a shared folder that is accessible to the accounts under which all Intel
EMA Web Server components, all Recovery Server components, and the Manageability Server com-
ponent are running (see Section 2.2.1.10). This folder will be used by Intel EMA to store uploaded
image files and to access those stored image files when mounting an image file to a managed end-
point.

l Intel EMA version 1.5.0 and later uses LDAPS secure ports by default (LDAPS secure port 636 and
Global Catalog port 3269). Previous versions of Intel EMA used the standard non-secure LDAP ports
(LDAP port 389 and Global Catalog port 3268). If you are installing Intel EMA v 1.5.0 or later, and are
using Active Directory or 802.1x integration, ensure the LDAPS ports are enabled. If you prefer to use
the standard non-secure ports, then after installing Intel EMA, open the installer program again
(EMAServerInstaller.exe, run as administrator) and select File > Advanced Mode, then click Settings
> Switch from LDAPs to LDAP to reset the LDAP ports Intel EMA uses to the standard non-secure
ports. Alternatively, you can change the ports in the Web server settings on the Server Settings page
in the Intel EMA UI. If you experience problems with 802.1x setup during Intel AMT provisioning, this
could be the issue. See the following link for more information: https://docs.microsoft.com/en-
us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts.

l Intel EMA distributed architecture allows you to install the Ajax and Web Server components, the
Swarm Server component, the Recovery Server component, and Manageability server component
onto separate physical or virtual servers. You also have the option of setting up multiple Ajax and
Web Servers, multiple Recovery Servers, and multiple Swarm Servers behind load balancers. You
can only set up one instance of the Manageability Server component. If you are not sure what order
you want to deploy these components, we suggest starting with Swarm Servers, then Ajax and Web

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
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Servers, then the Recovery Servers, and finishing with the Manageability Server.

l The initial server installation in a distributed server architecture will perform the initial database cre-
ation. Therefore, the account used to run the Intel EMA installer must have access to the
SQL database server with permissions to create a new database. After the database is created, you
can provide an application specific account for Intel EMA to use with appropriate database per-
missions. See Section 1.4.18.

l Prior to installing the initial server of a distributed server architecture, you must configure at least one
load balancer, consisting of a Swarm Server load balancer, a Recovery Server load balancer, and an
Ajax and Web server load balancer. This is NOT required if installing all Intel EMA server com-
ponents on the same machine or VM (see Section 2.1). If desired, these can be separate load bal-
ancers. The Ajax and Web server load balancer should use ports 443 and 8084, and must have
session persistence configured. The Recovery Server load balancer should use port 8085. The
Swarm Server load balancer should use port 8080 (session persistence not required). See the table
"Server network ports" on page 6 for details on the ports used by Intel EMA.

l Intel EMA does not support SSL offloading. The suggested load balancing rules and session per-
sistence based on IP address can be achieved by level-4 load balancers. Level-7 load balancers
can be used as long as SSL offloading is not enabled. Furthermore, Intel EMA front-end traffic
includes the Web socket type, so make sure the load balancer you use supports this.

l If you use multiple load balancers, make sure each load balancer has its own IP address and
DNS name, and that these values are fixed. Fixed IP address and DNS name values are required for
single load balancers as well.

l For the health monitoring rule of the Swarm server load balancer, use 8080 for the port and TCP for
the protocol. For the load balancing rule for the Swarm Server load balancer, use 8080 for the front-
end and back-end ports, TCP for the protocol, and do not enable session persistence.

l For the health monitoring rules of the Ajax and Web server load balancer 's port 8084, use 8084 for
port and TCP for protocol. For the load balancing rule of the Ajax and Web server load balancer's
8084 port, use 8084 for the front-end and back-end ports, TCP for the protocol, and enable session
persistence with "Client IP with long enough duration (e.g., 180 minutes)". For the health monitoring
and load balancing rules for this load balancer's port 443, simply substitute the value "443" for
"8084" in the preceding instructions.

l For the health monitoring rule of the Recovery server load balancer, use 8085 for the port and
TCP for the protocol. For the load balancing rule for the Recovery Server load balancer, use 8085 for
the front-end and back-end ports, TCP for the protocol, and do not enable session persistence.

l By default, the Intel EMA Platform Manager runs under the System account, and so do the com-
ponent servers (Ajax server, Swarm server, Recovery Server, Manageability server). In a distributed
server installation, these components may need access to a remote SQL Server, in which case you
need to change the account these components run under to one that can access the remote
SQL Server. See Section 1.4.17 for details on how to configure the account that these services run
under.

l The default IIS user account on your Ajax and Web servers will need to be configured with cre-
dentials that can access your remote SQL server. See section 1.4.9 for details.

l If your architecture includes multiple Ajax and Web server roles, you will need to synchronize the
machine keys between your IIS servers. Detailed steps for these procedures are covered in the dis-
tributed server installation flow, specifically in Section 2.2.1.11 (initial distributed server installation)
and 2.2.2.8 (additional distributed server installations).

l In distributed architecture installations, Intel EMA uses TLS certificates to secure communications
between the various servers and their components. After you set up your first server, you will need to
follow the process in Section 2.2.2.4.1 to create and install these TLS certificates for additional serv-
ers.
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2.1 Special Considerations for Installing All Components
on One Machine
Intel EMA allows you to install all server components of the distributed server architecture (i.e., Swarm Server, Ajax
Server, etc.) on the same machine (or virtual machine), if desired.

Note: This is still a distributed server architecture installation, not a single server architecture.

The installation process is essentially the same as installing the various components on separate machines.
However, there is one crucial difference with regard to the load balancer that is required when installing
components on separate machines.

When you install all components on the same machine, you do not need an actual load balancer. Therefore, during
installation, when asked to configure a load balancer, simply enter the IP Address or FQDN of the system on which
you are installing all Intel EMA server components.

IMPORTANT! If you plan to expand your Intel EMA server implementation to be truly distributed across
multiple machines or VMs in the future, you will need to configure an actual load balancer at that time. When
you do so, you MUST rename (FQDN) the machine on which you originally installed Intel EMA, and then
name (FQDN) the load balancer machine exactly what the original Intel EMA server machine was named.

This is because during installation, Intel EMA configures several certificates that govern communication
between the server components. The load balancer FQDN (or IP Address) is associated with these
certificates, and CANNOT be changed after installation. Therefore, if you configure a real load balancer at a
later time after installing all components on one machine, the load balancer FQDN MUST match the name
associated with the certificates.

This also applies to the IP Address of the original Intel EMA server machine and the load balancer; the
original server machine must be given a new IP Address, and the load balancer given the previous
IP Address of the original server machine, so that the load balancer's IP Address matches the certificates.

Lastly, when installing all components on the same machine or VM, you do not need to perform the steps in the
install wizard for installing additional servers.

2.2 Installing Using the Setup Wizard
2.2.1 Initial Server Installation

Note: Be sure to read all notes at the start of Section 2 before performing the steps in this section.

Extract the installation ZIP file, open the folder, and right-
click on EMAServerInstaller.exe and select Run as
administrator. The installer opens and the status bar at
the bottom shows Ready if the initial checks have
passed.

Click the top-left icon to begin the installation process.

Note: For assistance, click Help > Intel Support
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WARNING! For first-time installations, if you
continue with the installation process, the Intel
EMA Setup Wizard will delete everything in the
c:\inetpub\wwwroot folder. Be sure to backup any
needed files before continuing with the installation
process.

This does NOT apply when updating from a
previous Intel EMA version, although IIS bindings
will be set to default values. Click Next on the
Welcome screen to continue the setup process.
When the License Agreement is displayed, accept
the license to continue.

Click Next on the Welcome screen to continue the setup
process.

2.2.1.1 Server Host Configuration

Choose which installation type you want to perform. Do
not choose Standard Install for Single Server
Architecture if performing a distributed installation.

Initial Install for Distributed Server Architecture

One or more of the server components are
installed on this server machine, and
additional instances of components can
be installed on different server machines
using the Additional Server Install option
below.

This process also lets you specify a
configured load balancer to manage the
workload between the multiple server
machines.

Note: If you are installing all com-
ponents on one machine, you do
not need to perform the steps in the
Additional Server Install section.

Additional Server Install for Distributed Server
Architecture

Use this option AFTER completing the
Initial Install for Distributed Architecture
option above. This option allows you to
install additional server components on a
different server machine than the initial
distributed installation.

Skip to Section 2.2.2 "Additional Server
Installation" on page 29.
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2.2.1.2 Database Settings

Select the desired authentication type: Windows
Authentication, SQL Authentication, or Advanced Mode.

Note: For security purposes, we recommend that
Windows authentication mode is used for SQL
Authentication. If using SQL Authentication, you
must ensure the target credential is set up in the
SQL server first.

If you chose Windows Authentication the account you are
using for installation will be used to authenticate against
the SQL server and create the database.

Specify the server where the database is hosted. The
actual value depends on the database server you
installed. Refer to your SQL installation for details.

When the installation of Intel EMA is complete you can
change the account used to access the database by
modifying the service settings for the Intel Platform
Manager service in the Windows Services settings.

If you chose SQL Authentication or Advanced Mode you
will need to enter two sets of credentials

Notes:

l These two accounts must be created
ahead of time by a system administrator

l One used by the installer which
requires either db_owner, sysad-
min, or db_creator permissions.

l One for the Intel EMA services to
use after installation, which allows
the database service to be run with
lesser privileges.

l This account must be gran-
ted rights to connect to the
Intel EMA database and
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granted execute per-
missions for the dbo, man-
ageability, and security
schemas.

l If the account used by the
Intel EMA services is gran-
ted the sysadmin role, and
that is later removed,
access to the database will
no longer work.

l If you are using a SQL server installed on
the same machine as Intel® EMA then you
can use localhost.

l If you are using a remote SQL server,
ensure the SQL server’s account is set up
for your IIS Default Application Pool to con-
nect.

SQL Authentication:

l Specify the server where the database is hosted.
The actual value depends on the database server
you installed. Refer to your SQL installation for
details.

l Specify the SQL Server accounts that will be used
to create the database and the account that will
be used by the Intel EMA services to access the
database after installation is complete.

Advanced Mode:

l Specify two customized database connection
strings. One for installation of the database, and
one for the Intel EMA services to use after the Intel
EMA installation is complete.

For more information about connection strings, see
https://docs.microsoft.com/en-
us/dotnet/framework/data/adonet/connection-string-
syntax. Note that some examples on this page may not
be supported by Intel EMA.

Note: The parameter “Mul-
tipleActiveResultSets=True” is required. For more
information, see https://docs.microsoft.com/en-us/-
dotnet/framework/data/adonet/sql/enabling-mul-
tiple-active-result-sets.

The connection string is encrypted and stored in
c:\Program Files (x86)\Intel\Platform
Manager\Runtime\MeshSettings\connections.config.

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
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Important: If installing a distributed server archi-
tecture, copy the customized connection strings to
a text file to save it for use when installing addi-
tional servers.

Note: During an upgrade, the connection
information is displayed but cannot be edited as
part of the installation flow. See section 4.5 for
information on editing connection strings.

2.2.1.3 Load Balancer Information

For Identity mode:

l Use FQDN only: processes the request with the
FQDN only. We suggest entering the address-
able, full FQDN.

l Use FQDN first: processes the request using the
FQDN, but can also find the website via the IP
Address.

l Use IP address: processes requests with the IP
address only

Notes:

l A full FQDN is required to use the One
Click Recovery capability of Intel AMT. If
you plan to use the One Click Recovery
feature, you must enter a complete FQDN 
(server_name.domain), not just a host
name. Also, do not select Use IP Address
if you plan to use One Click Recovery.

l Intel AMT relies on DNS lookups to resolve
remote hosts. If you choose to use a short
name/host name for your server instead of
a DNS resolvable FQDN, Intel AMT remote
management functionality may not work
correctly.

Enter the FQDN and/or IP Address (or both, depending
on Identity mode) of the load balancer for the Swarm
Server.

Note: If you are installing all Intel EMA server
components on the same machine (or VM), enter
the FQDN and/or IP Address of the machine or
VM on which you are installing Intel EMA.

See Section 2.1 for special considerations in this
case.
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Enter the FQDN and/or IP Address (or both, depending
on Identity mode) of the load balancer for the Ajax Server
and Web Server components (or select Same as Swarm
Server).

Enter the FQDN and/or IP Address (or both, depending
on Identity mode) of the load balancer for the Recovery
Server component (or select Same as Swarm Server).

Note: If you plan to use domain/Windows authentication mode (Kerberos), you will need to set up a Service
Principle Name (SPN) for the load balancer that supports the Ajax and Web server(s).
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2.2.1.4 Server Components to Deploy

Specify which server components to deploy on this
server machine, then verify the IP Address of this server
machine (field filled in by default).

Note: Only one machine can run the
Manageability Server component.

For information about the various server components,
see Section 1.5.

2.2.1.5 Platform Manager Configuration

External Port is used by the Intel® EMA Platform
Manager service running on this Intel EMA server to
accept connection from the Intel EMA Platform Manager
client application. Make sure that the port you specify is
open in the underlying network.

This screen cannot be edited in update mode.

2.2.1.6 User Authentication

Choose which form of authentication you wish to use.
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2.2.1.6.1 Local Accounts

If you select Use local accounts then Intel® EMA will
keep an internal user database.

This is the default setting of the installation process. This
puts the installed instance in username/password mode.

2.2.1.6.2 Domain Authentication

If your server is joined to an Active Directory domain, you have the
option to Use domain authentication.

The currently logged-in user is automatically added to Intel EMA
with the Global Administrator role (shown as Site Administrator in
the screen at left).

Note: Intel EMA version 1.5.0 and later uses LDAPS secure
ports by default (LDAPS secure port 636 and Global Cata-
log port 3269). Previous versions of Intel EMA used the
standard non-secure LDAP ports (LDAP port 389 and
Global Catalog port 3268). If you are installing Intel EMA v
1.5.0 or later, and are using Active Directory or 802.1x integ-
ration, ensure the LDAPS ports are enabled. If you prefer to
use the standard non-secure ports, then after installing Intel
EMA, open the installer program again (EMAServer-
Installer.exe, run as administrator) and select File
> Advanced Mode, then click Settings > Switch from
LDAPs to LDAP to reset the LDAP ports Intel EMA uses to
the standard non-secure ports. Alternatively, you can
change the ports in the Web server settings on the Server
Settings page in the Intel EMA UI. If you experience prob-
lems with 802.1x setup during Intel AMT provisioning, this
could be the issue. See the following link for more inform-
ation: https://docs.microsoft.com/en-us/troubleshoot/win-
dows-server/identity/config-firewall-for-ad-domains-and-
trusts.

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
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2.2.1.6.3 Azure Active Directory Authentication

If your IT enviroment includes Azure Active Directory, you have the
option to choose Use Azure AD Authentication. This option allows
you to enter a username and password for the first account with
Global Administrator role. This account does not need to be in
Azure Active Directory. After installation, you can use this account
to log in and create the subsequent users, which must be in Azure
Active Directory.

2.2.1.7 Global Administrator Account Setup

This screen only appears during setup if you have
chosen “Normal accounts” or "Azure AD
Authentication" for user authentication. If using domain
accounts, the user running the installer will be made a
Global Administrator.

Note: The Name field must be entered in the form
of an email address (i.e., name@domain).

Global Administrator: This role is able to perform user
management, tenant creation, and server management.
This role does not perform device management. In Azure
AD environments, this user account is needed for
configuring Intel EMA as described in section 2.2.1.12.

2.2.1.8 Finishing Up

If you are planning to add more servers to this Intel EMA
installation, choose Yes. Proceed to the Summary
screen, then once the installation completes successfully,
perform the steps in sections 2.2.1.10 and 2.2.1.11.

If you do not plan to install more servers at this time,
choose No. The installer will automatically create a folder
required for the USBR feature (see the Intel® EMA
Administration and Usage Guide for more information on
this feature).

You do not need to perform the steps in sections 2.2.1.10
and 2.2.1.11 if you choose No on this screen.
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2.2.1.9 Summary

Review your installation settings and then click Install.

All required Windows components will be installed,
followed by the Intel® EMA software itself.

IMPORTANT: Do not abort or exit the installer
until installation is complete. Installation rollback
is not supported.

Installation status is shown at the bottom of the Installer
main menu. Installation options are unavailable during
installation.

To check the log file during installation, click File >
Advanced Mode. To exit Advanced Mode, click File >
Advanced Mode again.

After installation, you can check the logfile EMALog-
Intel®EMAInstaller.txt in the same folder as the Intel
EMA installer.

Note: The following warning appears in the installation log file regardless of whether you are installing with
a local SQL Server or a remote SQL Server. For installations with a remote SQL Server, this message can be
ignored. For local SQL server installations, ensure the the account is set up to allow your IIS Default Applic-
ation Pool to connect.
EVENT: DbWarning, ExecuteNonQuerySafe warning: CREATE LOGIN [IIS
APPPOOL\DefaultAppPool] FROM WINDOWS() - System.Data.SqlClient.SqlException
(0x80131904): User does not have permission to perform this action.

If you are only installing one server at this time, you are now ready to log in as the Global Administrator and click
View Getting Started tips under Getting Started on the overview page. See section 3. Otherwise, proceed to
section 2.2.1.10.

2.2.1.10 Create Shared Folder

The USB Redirection (USBR) and One Click Recovery (OCR) features of Intel EMA allows you to mount a
remote disk image (.iso or .img) to a managed endpoint via Intel AMT. To enable this feature, you must create a
shared folder that is accessible to the accounts under which all Intel EMA Web Server components and the
Manageability Server component are running. This folder will be used by Intel EMA to store uploaded image files
and to access those stored image files when mounting an image file to a managed endpoint.

Notes:

l This procedure is not required on additional servers in a distributed server installation.

l This procedure is not required if you installing only one server at this time.

Follow the steps below.

1. Create a folder on the initial Intel EMA server or a location that will be accessible to all Intel EMA servers in
the distributed server installation.

2. Set Sharing for the folder so that the accounts under which the Intel EMA Web Server component (on all
servers in the distributed installation), the Recovery Server, and the Intel EMA Manageability Server
component are running can access this shared folder. The account for the Web Server (IIS) needs read/write
access. The account for the Manageability Server needs read access. Sharing can be set by right-clicking
the folder name in Windows Explorer, selecting Properties, then selecting the Sharing tab.
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3. Launch the Intel EMA web-based UI and log in as the Global Administrator (see Section 3).

4. From the navigation panel at left, select Settings and then select the Server Settings tab.

5. For the Manageability Server, set the USBR Images Root Directory setting to the shared folder you just
created (for example, \\myserver.domain.com\sharename). For more information about Server Settings,
see Section 6.3.

2.2.1.11 Modify IIS Settings If Ajax and Web Server Components Installed

Note: This procedure is not required if you installing only one server at this time.

If you selected the Ajax and Web Server components on the Server Components to Deploy screen above, you
need to modify your IIS settings to set up fixed machine keys. This will allow other Web Servers to use the same
keys if you install additional server components on other virtual or physical machines.

1. In IIS Manager, stop the Default Web Site.

2. In IIS Manager, open your server in the left-hand pane and double-click the Machine Key section under
ASP.NET and set the Encryption method to AES and the Validation method to one of the SHA-2 family meth-
ods (for example, HMACSHA256).

3. Under Actions at right, click Generate Keys to generate the Validation key and the Decryption key. You will
need these keys later when you install additional servers (see Section 2.2.2).

4. Click Apply and then restart the Default Web Site.

If you are installing in Azure AD authentication mode, proceed to section 2.2.1.12. Otherwise, you are ready to
install additional Intel EMA servers, as described in Section 2.2.2.

2.2.1.12 Modify Server Settings for Azure AD

Note: These steps are only needed if you installed Intel EMA using Azure AD authentication mode.

The following steps are performed on the Server Settings tab of the Intel EMA user interface. See Section 6,
"Appendix - Modifying Component Server Settings" on page 70 for more information about component server
settings. These steps must be performed before you can add additional users in Azure AD authentication mode.

1. Login to Intel EMA using the initial Global Administrator (root GA) account with its username and password.

2. Navigate to the Server Settings page, then the Web Server settings.

3. Using the values that you copied and saved in section 1.3.4, enter the Azure AD Directory (tenant) ID, the
Azure AD Application (client) ID, and the Azure AD Client Secret Value.

Note: Use the Save and Sync Web Settings button to restart the web server. Alternatively, you can run the
Intel EMA installer EMAServerInstaller.exe (as Administrator) and select Settings > Sync Web Server Set-
tings from the menu bar.

When these settings are updated the Intel EMA Server will do a test to verify a connection to the Azure AD
enviroment is successful.

At this point, you are ready to install additional Intel EMA servers, as described in Section 2.2.2.

2.2.2 Additional Server Installation

Notes:

l If you are installing all components on one machine at this time, you do not need to perform the steps
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in this section.

l You must complete the steps in Section 2.2.1 before performing the steps in this section (or you can
reference any existing Intel EMA server already in your distributed server architecture).

l By default, the Intel EMA Platform Manager runs under the System account, and so do the com-
ponent servers (Ajax server, Swarm server, Recovery Server, Manageability server). In a distributed
server installation, these components may need access to a remote SQL Server, in which case you
need to change the account these components run under to one that can access the remote
SQL Server. See Section 1.4.17 for details on how to configure the account that these services run
under.

l The default IIS user account on your Ajax and Web servers will need to be configured with cre-
dentials that can access your remote SQL server. See section 1.4.9 for details.

Run the Intel EMA installer EMAServerInstaller.exe (run as Administrator), choose Install or Update, then click
Next at the Welcome screen. At the Server Host Configuration screen, choose Additional Server Install for
Distributed Server Architecture.

2.2.2.1 Database Settings

Select the desired authentication type: Windows
Authentication, SQL Authentication, or Advanced Mode.

Note: For security purposes, we recommend that
Windows authentication mode is used for SQL
Authentication. If using SQL Authentication, you
must ensure the target credential is set up in the
SQL server first.

If you chose Windows Authentication the account you are
using for installation will be used to authenticate against
the SQL server and create the database.

Specify the server where the database is hosted. The
actual value depends on the database server you
installed. Refer to your SQL installation for details.

When the installation of Intel EMA is complete you can
change the account used to access the database by
modifying the service settings for the Intel Platform
Manager service in the Windows Services settings.
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If you chose SQL Authentication or Advanced Mode you
will need to enter two sets of credentials

Notes:

l These two accounts must be created
ahead of time by a system administrator

l One used by the installer which
requires either db_owner, sysad-
min, or db_creator permissions.

l One for the Intel EMA services to
use after installation, which allows
the database service to be run with
lesser privileges.

l This account must be gran-
ted rights to connect to the
Intel EMA database and
granted execute per-
missions for the dbo, man-
ageability, and security
schemas.

l If the account used by the
Intel EMA services is gran-
ted the sysadmin role, and
that is later removed,
access to the database will
no longer work.

l If you are using a SQL server installed on
the same machine as Intel® EMA then you
can use localhost.

l If you are using a remote SQL server,
ensure the SQL server’s account is set up
for your IIS Default Application Pool to con-
nect.

SQL Authentication:

l Specify the server where the database is hosted.
The actual value depends on the database server
you installed. Refer to your SQL installation for
details.

l Specify the SQL Server accounts that will be used
to create the database and the account that will
be used by the Intel EMA services to access the
database after installation is complete.

Advanced Mode:

l Specify two customized database connection
strings. One for installation of the database, and
one for the Intel EMA services to use after the Intel
EMA installation is complete.
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For more information about connection strings, see
https://docs.microsoft.com/en-
us/dotnet/framework/data/adonet/connection-string-
syntax. Note that some examples on this page may not
be supported by Intel EMA.

Note: The parameter “Mul-
tipleActiveResultSets=True” is required. For more
information, see https://docs.microsoft.com/en-us/-
dotnet/framework/data/adonet/sql/enabling-mul-
tiple-active-result-sets.

The connection string is encrypted and stored in
c:\Program Files (x86)\Intel\Platform
Manager\Runtime\MeshSettings\connections.config.

Important: If installing a distributed server archi-
tecture, copy the customized connection strings to
a text file to save it for use when installing addi-
tional servers.

Note: During an upgrade, the connection
information is displayed but cannot be edited as
part of the installation flow. See section 4.5 for
information on editing connection strings.

2.2.2.2 Server Components to Deploy

Specify which server components to deploy on this
server machine, then verify the IP Address of this server
machine (field filled in by default).

Note: Only one machine can run the
Manageability Server component. If you want to
install a Manageability Server component on an
additional server, you must remove any other
installation of the Manageability Server.

For information about the various server components,
see Section 1.5.

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
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2.2.2.3 Save the Server Settings Certificate Signing Request

This screen lets you save a Certificate Signing Request
(CSR) for the server settings, which is needed to connect
your new server to your existing distributed server
environment.

1. Click Save serverSettings.csr.

2. Select where to save the certificate signing
request file.

Note: Be sure to save the .csr file to a loc-
ation where it can be accessed from the ini-
tial server you installed in Section 2.2.1
(such as a shared network drive access-
ible from both machines or a USB drive).

3. Click Next.

2.2.2.4 Obtain Server Setting Certificate

On the initial server you installed in Section 2.2.1,
perform the steps in Section 2.2.2.4.1 below.

Once you have created the Server Settings Certificate on
the initial server, click Next to proceed with the Additional
Server installation.

2.2.2.4.1 Create Server Settings Certificate on Initial Distributed Server Machine

Perform the following steps on the machine (physical or virtual) where you performed the initial server installation
(Section 2.2.1). These steps must be completed before proceeding to the next Setup Wizard screen of the
additional server installation.

1. Run the Intel EMA installer, EMAServerInstaller.exe. Be sure to Run as administrator.

2. From the menu bar at top, click File > Create Server Settings Certificate.

3. Browse to the location where you saved (or copied) the Certificate Signing Request (.csr) file in Section
2.2.2.3 above.
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4. Click Save Certificate to save the new certificate (.cer) file.
Note: Be sure to save the .cer file to a location where it can be accessed from the additional server
you are installing (such as a shared network drive accessible from both machines or a USB drive).

5. Once the "Saved .cer file" message is displayed, click Exit to close the dialog, then click File > Exit on the
Intel EMA Server Installer.

2.2.2.5 Upload Server Setting Certificate

1. Click Upload Server Settings Certificate.

2. Select the certificate file (.cer) that you created on
the initial distributed server machine in the pre-
vious step.

2.2.2.6 Platform Manager Configuration

External Port is used by the Intel® EMA Platform
Manager service running on this Intel EMA server to
accept connection from the Intel EMA Platform Manager
client application. Make sure that the port you specify is
open in the underlying network.

This screen cannot be edited in update mode.
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2.2.2.7 Summary

Review your installation settings and then click Install.

All required Windows components will be installed,
followed by the Intel® EMA software itself.

IMPORTANT: Do not abort or exit the installer
until installation is complete. Installation rollback
is not supported.

Installation status is shown at the bottom of the Installer
main menu. Installation options are unavailable during
installation.

To check the log file during installation, click File >
Advanced Mode. To exit Advanced Mode, click File >
Advanced Mode again.

After installation, you can check the logfile EMALog-
Intel®EMAInstaller.txt in the same folder as the Intel
EMA installer.

Note: The following warning appears in the installation log file regardless of whether you are installing with
a local SQL Server or a remote SQL Server. For installations with a remote SQL Server, this message can be
ignored. For local SQL server installations, ensure the the account is set up to allow your IIS Default Applic-
ation Pool to connect.
EVENT: DbWarning, ExecuteNonQuerySafe warning: CREATE LOGIN [IIS
APPPOOL\DefaultAppPool] FROM WINDOWS() - System.Data.SqlClient.SqlException
(0x80131904): User does not have permission to perform this action.

2.2.2.8 Modify IIS Settings If Ajax and Web Server Components Installed

If you selected the Ajax and Web Server components on the Server Components to Deploy screen during
additional server installation above, you need to modify your IIS settings to use the fixed machine keys created on
the initial distributed server installation (Section 2.2.1).

1. In IIS Manager, stop the Default Web Site.

2. Double-click the Machine Keys section and set the Encryption method to AES and the Validation method to
one of the SHA-2 family methods (for example, HMACSHA256).

3. Deselect the Generate Keys option, then set the values for the Validation key and the Decryption key to the
values used for the initial distributed server (see Section 2.2.1.11).

4. Click Apply and then restart the Default Web Site.

2.2.2.9 Modify Server Settings

The following steps are performed on the Server Settings tab of the Intel EMA user interface. See Section 6,
"Appendix - Modifying Component Server Settings" on page 70 for more information about component server
settings.

1. Open a browser and navigate to the URL of the Ajax and Web server load balancer that you configured as
part of you initial server installation. The Intel EMA website user interface is displayed.

2. At the login page, enter the user name and password for the Global Administrator. The Overview page is dis-
played.

3. From the navigation pane at left, select Settings to open the Server Settings page.
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4. On the Swarm Server tab, click Add Entry.

5. For Server ID, you will need to review the Intel EMA database, specifically the [dbo].[ServerSettings] table.
The correct Server ID value on this dialog will be the value of ValueInt field in the database table with Type
= 2 and for the server Name corresponding to your new additional server.

6. For IP Address and Port, if a Swarm Server was selected for installation on this additional server, enter the
IP Address of the Swarm Server. For the port, enter the port number (e.g., 8089) that is shown in the Admin
Port field at the top of the Swarm Server tab. The format for this field is [IP Address]:[Port] (for
example, 123.456.789.10:8089).

7. For Server IPs, ensure all IP addresses of all physical or virtual servers in this distributed Intel EMA server
environment are listed.

8. Click Save Settings. At this time, do not use the Save and Restart Server button.

9. Repeat the above process on each of the Ajax and Manageability component server tabs. Note that only the
Swarm server tab has the Admin Port field, so use the same value in the IP Address and Port field on the
other server tabs.

10. Once all tabs have been updated, on each server machine in the distributed server environment, run Plat-
form Manager and restart all server components on each machine using Platform Manager's Halt and
Launch commands. Also recycle the Intel EMA website's IIS app pool if you installed the Intel EMA Web and
Ajax components on that machine. Alternatively, you can restart each server machine in the distributed
server environment.

At this point, you are ready to log in as the Global Administrator and click View Getting Started tips under Getting
Started on the overview page. See section 3.

2.3 Performing an Update Installation Using the Setup
Wizard
Follow the steps below to perform an update installation using the Intel EMA setup wizard.

Update Installation Notes:

l If you are updating an existing Single Server Architecture environment, see Section 9, "Appendix -
Updating a Single Server Architecture Environment" on page 84 for detailed procedures for this oper-
ation.

l When upgrading an Intel EMA instance, the account under which the Platform Manager service runs
reverts to Local System. If you are running that service under another local or domain account, it will
need to be reconfigured and all Intel EMA components halted and restarted after the upgrade is
complete.

l If you are updating from an existing version of Intel EMA, the Intel EMA website’s bindings in IIS will
be set to default values during the update installation. You can check the log files after installation to
find the pre-update bindings for your reference.

l The Intel EMA Agent software on managed endpoints is automatically updated upon connecting to
the updated Intel EMA server instance for the first time after server update. For Intel EMA version
1.5.0 and later, this automatic update is only performed if the Swarm Server setting Agent Auto
Update is enabled (default). See section 6.1 for details.

l When updating a distributed architecture installation, you must stop all Intel EMA components except
the Platform Manager service on all servers in your distributed architecture before starting the update
install on any of the servers. If you stop the Platform Manager service you will see errors logged for
the installation.

l Use the Platform Manager to stop all Swarm, Ajax, Recovery, and Manageability components on all
servers. Use IIS to stop all Web Server components on all servers.

l Update the Intel EMA server machines one at a time (i.e., complete the installation on one machine
before starting it on the next). The order in which you update your server machines does not matter.
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l Use the same process below on all your Intel EMA server machines.

l When the update installation finishes, the components on that server machine will be restarted auto-
matically.

Extract the installation ZIP file, open the folder, and
right-click on EMAServerInstaller.exe and select Run
as administrator. The installer opens and the status
bar at the bottom shows Ready if the initial checks
have passed.

Click the top-left icon to begin the installation process.

Note: For assistance, click Help > Intel
Support

The installer detects that you are performing an
update installation and informs you that your IIS
web.config file will be renamed to allow an updated
file to be installed.

Click OK.

Click Next on the Welcome screen to continue the
setup process.

Note: The warning regarding IIS being
installed does not apply to update
installations.
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Select which type of installation update you are
performing: Single Server Architecture or Distributed
Server Architecture. This screen is only displayed if
you are updating from a version prior to v1.6.0.

IMPORTANT! Selecting an installation type
that does not match your existing installation
will result in a non-functioning Intel
EMA instance that will need to be fully unin-
stalled and reinstalled. Make sure the type you
select matches the type that is currently
installed. This action cannot be undone once
you complete the update.

Click Next.

2.3.1 Database Settings

The screen displayed depends on the authentication
type you selected when initially installing.

Note: For update mode, the fields are filled in and
cannot be changed.
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2.3.2 Load Balancer Information

Note: This screen is only displayed during
updates from Intel EMA versions less than v1.6.0.

Enter the FQDN and/or IP Address (or both, depending
on Identity mode) of the load balancer for the Recovery
Server component.

Note: A full FQDN is required for One Click
Recovery. If you plan to use the One Click Recov-
ery feature, you must enter a complete FQDN 
(server_name.domain), not just the server name.
Also, do not only enter the IP Address if you plan
to use One Click Recovery.

2.3.3 Server Components to Deploy

Specify which server components to deploy on this
server machine.

Notes:

l Only one machine can run the
Manageability Server component.

l Server components already deployed on
this machine are shown grayed out and
cannot be edited.

l If you select a new component to deploy
on this machine, the Server IP Address
field is displayed so you can enter this
machine's IP Address.

For information about the various server components,
see Section 1.5.
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2.3.4 Platform Manager Configuration

External Port is used by the Intel® EMA Platform
Manager service running on this Intel EMA server to
accept connection from the Intel EMA Platform Manager
client application. Make sure that the port you specify is
open in the underlying network.

This screen cannot be edited in update mode.

2.3.5 Summary

Review your installation settings and then click Install.

All required Windows components will be installed,
followed by the Intel® EMA software itself.

IMPORTANT: Do not abort or exit the installer
until installation is complete. Installation rollback
is not supported.

Installation status is shown at the bottom of the Installer
main menu. Installation options are unavailable during
installation.

To check the log file during installation, click File >
Advanced Mode. To exit Advanced Mode, click File >
Advanced Mode again.

After installation, you can check the logfile EMALog-
Intel®EMAInstaller.txt in the same folder as the Intel
EMA installer.

Once the update installation has completed, all components on this Intel EMA server machine will be restarted.
Update the remaining server machines in your distributed installation.

Note: Be sure to verify that the shared folder for the USBR and OCR features exists, and if not, create one by
following the steps in section 2.2.1.10. This folder will be used by Intel EMA to store uploaded image files
and to access those stored image files when mounting an image file to a managed endpoint.

2.4 Installing or Updating Using the Command Line
This section describes how to install or update from the command line.

Note: The installer requires a relative path to the installer executable EMAServerInstaller.exe. You cannot
use an absolute path when issuing the installer command. Change directory to the directory where
EMAServerInstaller.exe is located and issue the command from that folder.
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Use the command examples in this section to install a distributed server architecture instance of the Intel
EMA server For updates to an existing version, see section 2.4.3.

2.4.1 Initial Installation
To install the initial server of a distributed server architecture, use the syntax below , substituting correct values for
the placeholder values <in brackets> in the example .

EMAServerInstaller FULLINSTALL --isdistributedserverinit --swarmlbhost=<swarmHostLBFQDN>
--swarmlbip=<w.x.y.z> --ajaxlbhost=<ajaxHostLBFQDN> --ajaxlbip=<w.x.y.z>
--recoverylbhost=<recoveryHostLBFQDN> --recoverylbip=<w.x.y.z>
--emaip=<current machine IP address> [--ipfirst|--hostfirst] --dbserver=<dbServer>
--db=<dbName> --guser=<UserName> --gpass=<UserPassword> --deployajaxandweb
--deploymanageability --deployswarm --deployrecovery --createDefaultUsbrFolder
--accepteula -c -v

Note: If you are installing only one server machine at this time, you must use the --cre-
ateDefaultUsbrFolder flag to ensure the required folder for the USBR feature is created. For more inform-
ation on this feature, see the Intel® EMA Administration and Usage Guide.

The grouping of descriptions below corresponds to the flow of screens in the installation wizard.

General

FULLINSTALL indicates that action to perform is installation

-c to run in console mode, required

-v for verbose output, optional but reccomended

--accepteula to accept the license agreement, required. The EULA can be viewed in the extracted
install package zip in the “Licenses” folder

--help can be used to view the full help text for the installer

Server Host Configuration

--isdistributedserverinit Use this flag for initial install for distributed server

Database Settings

Note: Two database accounts are required: one of the installer which requires DB Owner permissions, and
one for the Intel EMA services, which allows the database service to be run with lesser privileges.

For the database connection, use the following:

Windows Authentication: --db=<DBName> and -–dbserver=<DBServerName>

SQL Authentication: --db=<DBName> and -–dbserver=<DBServerName>
--dbuserinstaller=<UserId>, --dbpassinstaller=<Password>, --

dbuserservice=<UserId> and --dbpassservice=<Password>

The --dbadvanced parameters are used to provide a customized database connection string for the installer or the
service; the connection strings are encrypted and stored in c:\Program Files (x86)\Intel\Platform
Manager\Runtime\MeshSettings\connections.config.
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--dbadvancedinstaller= “<connection_string>” OR --dbadvancedservice=
“<connection_string>”

For more information about connection strings, see https://docs.microsoft.com/en-
us/dotnet/framework/data/adonet/connection-string-syntax. Note that some examples on this page may not be
supported by Intel EMA.

Note: The parameter “MultipleActiveResultSets=True” is required. For more information, see https://-
docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets.

Load Balancer Information

For identity mode:

No flag use FQDN only, provide FQDN only

--hostfirst use FQDN first, provide FQDN and IP address

--ipfirst use IP address, provide IP address only

If using FQDN use the following flags:

--swarmlbhost=<swarmHostLBFQDN>

--ajaxlbhost=<ajaxHostLBFQDN>

--recoverylbhost=<recoveryHostLBFQDN>

If using IP use the following flags:

--swarmlbip=<w.x.y.z>

--ajaxlbip=<w.x.y.z>

--recoverylbhost=<w.x.y.z>

Server Components to Deploy

Use the flags below to select which components to deploy:

--deployajaxandweb --deploymanageability --deployswarm -–deployrecovery

Also, you must use this flag to set the information for this server IP address:

--emaip=<w.x.y.z>

User Authenticaion and Global Admin Account Setup

--guser=<Username> --gpass=<userpassword> Username/password authentication

--domainauth Windows domain authentication

--AzureAdauth --guser=<Username> --gpass=<userpassword> Azure AD authentication

Finishing up

--createDefaultUsbrFolder If you are installing only one server machine at this time, you

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
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must use this flag to ensure the required folder for the
USBR feature is created.

2.4.2 Add an Additional Server
Overall syntax:

EMAServerInstaller FULLINSTALL --isdistributedserveradd --emaip=<current machine
IP address> --dbserver=<dbServer> --db=<dbName>
--certimeoutseconds=<timeOutSeconds> --csrfile=<csrFilePath>
--cerfile=<cerFilePath> --deployajaxandweb --deploymanageability --deployswarm
--deployrecovery --accepteula -c -v

General

FULLINSTALL indicates that action to perform is installation

-c to run in console mode, required

-v for verbose output, optional but reccomended

--accepteula to accept the license agreement, required. The EULA can be viewed in the extracted
install package zip in the “Licenses” folder

--help can be used to view the full help text for the installer

Server Host Configuration

--isdistributedserveradd Use this flag for additional distributed server install.

Database Settings

For the database connection, use the following:

Windows Authentication: --db=<DBName> and -–dbserver=<DBServerName>

SQL Authentication: --db=<DBName> and -–dbserver=<DBServerName>
--dbuserinstaller=<UserId>, --dbpassinstaller=<Password>, --

dbuserservice=<UserId> and --dbpassservice=<Password>

The --dbadvanced parameters are used to provide a customized database connection string for the installer or the
service; the connection strings are encrypted and stored in c:\Program Files (x86)\Intel\Platform
Manager\Runtime\MeshSettings\connections.config.

--dbadvancedinstaller= “<connection_string>” OR --dbadvancedservice=
“<connection_string>”

For more information about connection strings, see https://docs.microsoft.com/en-
us/dotnet/framework/data/adonet/connection-string-syntax. Note that some examples on this page may not be
supported by Intel EMA.

Note: The parameter “MultipleActiveResultSets=True” is required. For more information, see https://-
docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets.

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
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Server Components to Deploy

Use the flags below to select which components to deploy:

--deployajaxandweb --deploymanageability --deployswarm -–deployrecovery

Also, you must use this flag to set the information for this server IP address:

--emaip=<w.x.y.z>

Save the Server Settings Certificate Signing Request

--csrfile=<csrFilePath> Path to save the CSR file. If not provided default value of
“.\serversettings.csr” will be used.

--certimeoutseconds=<timeOutSeconds> Timeout value to pause waiting for CER file.

Upload Server Settings Certificate

--cerfile=<cerFilePath> Path for the CER file. If not provided default value of “.\ser-
versettings.cer” will be used.

To install an additional server in a distributed server architecture, perform the following steps, substituting correct
values for the placeholder values <in brackets> in the examples.

1. Begin the installation on the additional server machine by entering the above command using the flags as
described. The installation will pause in order to consume the files created in the remaining steps. The
installer command will pause for the length of time specified in the --certimeoutseconds option. Note
that if --csrfile option is not provided, the default of .\serversettings.csr will be used (same for the cerfile,
but with a .cer extension).

2. When the installer pauses, copy the generated certificate request (.csr) file to the initial server machine.

3. On the initial server machine, run the installer with the createsettingscert option, as shown below:

EMAServerInstaller CREATESETTINGSCERT --csrfile=<csrFilePath>
--cerfile=<cerFilePath> -c -v -a

Note: Alternatively, you can run the Intel EMA installer setup wizard on the initial server and click File
> Create Server Settings Cert, as described in Section 2.2.2.4.1.

4. On the initial server, copy the resulting certificate (.cer) file to the additional server machine. Or you can spe-
cify a shared folder accessible by both machines to save the .cer file to in the previous step, as long as you
specify the same location in the --cerfile option of the installer command in step 1 above.

5. On the additional server, the installation will automatically continue once it detects the certificate (.cer) file in
the location specified in the --cerfile option.

2.4.3 Performing an Update Installation Using the Command Line

Update Installation Notes:

l If you are updating an existing Single Server Architecture environment, see Section 9, "Appendix -
Updating a Single Server Architecture Environment" on page 84 for detailed procedures for this oper-
ation.

l When upgrading an Intel EMA instance, the account under which the Platform Manager service runs
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reverts to Local System. If you are running that service under another local or domain account, it will
need to be reconfigured and all Intel EMA components halted and restarted after the upgrade is
complete.

l If you are updating from an existing version of Intel EMA, the Intel EMA website’s bindings in IIS will
be set to default values during the update installation. You can check the log files after installation to
find the pre-update bindings for your reference.

l The Intel EMA Agent software on managed endpoints is automatically updated upon connecting to
the updated Intel EMA server instance for the first time after server update. For Intel EMA version
1.5.0 and later, this automatic update is only performed if the Swarm Server setting Agent Auto
Update is enabled (default). See section 6.1 for details.

l When updating a distributed architecture installation, you must stop all Intel EMA components except
the Platform Manager service on all servers in your distributed architecture before starting the update
install on any of the servers. If you stop the Platform Manager service you will see errors logged for
the installation.

l Use the Platform Manager to stop all Swarm, Ajax, Recovery, and Manageability components on all
servers. Use IIS to stop all Web Server components on all servers.

l Update the Intel EMA server machines one at a time (i.e., complete the installation on one machine
before starting it on the next). The order in which you update your server machines does not matter.

l Use the same process below on all your Intel EMA server machines.

l When the update installation finishes, the components on that server machine will be restarted auto-
matically.

Use the command example below to update each Intel EMA server machine in an existing distributed server
architecture installation. Use the two recovery server parameters when recovery server settings do not exist.

Overall syntax:

EMAServerInstaller FULLINSTALL --updateinstalltype=<single/distributed> --emaip=<current
machine IP address> --recoverylbhost=<recoveryHostLBFQDN> --recoverylbip=<w.x.y.z>
--deployajaxandweb --deploymanageability --deployswarm --deployrecovery --accepteula -c -
v

General

FULLINSTALL indicates that action to perform is installation

-c to run in console mode, required

-v for verbose output, optional but reccomended

--accepteula to accept the license agreement, required. The EULA can be viewed in the extracted
install package zip in the “Licenses” folder

--help can be used to view the full help text for the installer

Update install:

Only needed during updates from Intel EMA versions less than v1.6.0.

--updateinstalltype=<single/distributed> For updateinstalltype, you must correctly specify
which type of installation (single server architecture or
distributed server architecture) you are currently updat-
ing. Specifying the wrong type will result in an inop-
erable Intel EMA instance which must be fully
uninstalled and reinstalled.
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Load balancer:

Only needed during updates from Intel EMA versions less than v1.6.0.

If using FQDN use the following flags:

--recoverylbhost=<recoveryHostLBFQDN>

If using IP use the following flags:

--recoverylbhost=<w.x.y.z>

Server Components to Deploy

Use the flags below to select which components to deploy. These are optional and only needed if you want to
install additional components not already installed on this server. Any server components already deployed on this
machine will be updated as part of the update install.

--deployajaxandweb --deploymanageability --deployswarm -–deployrecovery

Also, you must use this flag to set the information for this server IP address:

--emaip=<w.x.y.z>

Notes:

l For updates from previous Intel® EMA versions, only the updateinstalltype, emaip,
deployajaxandweb, deploymanageability, deployswarm, deployrecovery, recoverylbhost,
recoverylbip, accepteula, console (c), and verbose (v) parameters are accepted. Do not enter any
other parameters for updates. Doing so will cause the installation to abort and an error message to
be displayed. Note that emaip and the deployxxx parameters are only required if you want to
deploy new, additional component servers (i.e., a new Swarm Server) on this machine.

l For updateinstalltype, you must correctly specify which type of installation (single server architecture
or distributed server architecture) you are currently updating. Specifying the wrong type will result in
an inoperable Intel EMA instance which must be fully uninstalled and reinstalled.

2.4.4 Converting to Azure AD Using the Command Line

IMPORTANT! It is HIGHLY recommended that you perform a backup of the Intel EMA database
BEFORE using this command. The switch cannot be undone, but you can manually restore your database
from the backup if you decide you want to reverse this action.

Use the command example below to convert your existing Intel EMA installation from Windows Authentication to
Azure AD Authentication. A root Global Administrator account will be created during this process.

For the username you can specify a username of an existing Global Admin account, or you can choose to create a
new username for the root Global Admin account. You must provide a password to use with this root Global Admin
account, and all future logins to Intel EMA with this account will use username/password to login.

Note: Intel EMA instances configured to use Azure AD authentication do not support individual user authen-
tication via the REST API from scripts or outside applications. Use of Client Credential authentication is a
supported alternative on these instances. If you require the use of integrating applications or administrative
scripts that call Intel EMA’s APIs, verify that they will work with Azure AD authentication before proceeding
with a production deployment.
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After using this command, restart the Web Server (or recycle the application pool) for each Intel EMA website on
each machine on which the Web Server is installed (note that it is not sufficient to simply restart the web site). Use
IIS Manager to do this.

After using this command and restarting the Web Servers in IIS, go to the Intel EMA login page and refresh the page
at least twice. At this point the Azure AD SSO login option should be displayed.

EMAServerInstaller SWITCHTOAZUREAD --guser=<UserName> --gpass=<UserPassword> -c -v

--guser=<UserName> specifies the username to use for root Global Admin account. This can be a new username
or the username of an existing Global Admin account.

--gpass=<UserPassword> specifies the password to use for the root Global Admin account.

2.5 Uninstalling
Do not abort or exit the installer before the uninstallation is complete.

Notes:

l Before uninstalling, ensure the account used in the Intel EMA SQL connection string has at least db_
creator rights, which allow it to create, modify, and delete any database. This account must also have
the database level roles db_owner, db_datawriter, and db_datareader.

l If you uninstall Intel EMA but do not delete the database, it is recommended that you remove the
machine's IP address from the Server IPs server setting. On the Server Settings page (as a Global
Administrator), select the tab for the component(s) hosted on this machine, then under Server IPs,
select the correct IP address and click Remove Entry. Then click Save and Restart Server. Be sure to
do this for each component on the machine where you uninstalled Intel EMA. See Section 6
"Appendix - Modifying Component Server Settings" on page 70.

2.5.1 Uninstalling Using the Installer GUI
1. On the Installer main menu, click the Uninstall the Intel® EMA Server option at bottom.

2. On the dialog, decide whether you want to delete the settings certificate.

3. Decide whether you want to delete the database.
WARNING! If this is a distributed server architecture installation, this option will make the entire Intel
EMA instance unusable. Use this option only if this is the last remaining server.

Note: If the database is managed and/or cloud-based, Intel EMA cannot delete the database so do
not specify this option.

4. Click OK, then click OK to the warning message.

5. After the uninstall is complete, check the log by clicking File > Advanced Mode to confirm successful com-
pletion.

2.5.2 Uninstalling Using the Command Line

Note: The installer requires a relative path to the installer executable EMAServerInstaller.exe. You cannot
use an absolute path when issuing the installer command. Change directory to the directory where
EMAServerInstaller.exe is located and issue the command from that folder.

1. Open a command prompt window with administrative privileges.

2. Change directory to where the Intel EMA Installer Package was extracted.

3. To uninstall without removing the database and settings certificate, type the UNINSTALL command below
and press Enter.
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EMAServerInstaller UNINSTALL -c --verbose

4. To uninstall and remove the settings certificate, add the --deletesettingscert option.

EMAServerInstaller UNINSTALL --deletesettingscert –c --verbose

5. To uninstall and remove the database, add the --deletedb option, shown below (to remove both the set-
tings certificate and the database, use both options).

EMAServerInstaller UNINSTALL --deletedb –c --verbose

WARNING! If this is a distributed server architecture installation, this option will make the entire Intel
EMA instance unusable. Use this option only if this is the last remaining server.

Note: If the database is managed and/or cloud-based, Intel EMA cannot delete the database so do
not specify this option.

2.6 Intel® EMA Installer Advanced Mode Menu Bar
By default, the Intel EMA installer EMAServerInstaller.exe menu bar has two choices: File and Help. Selecting
File > Advanced Mode displays an expanded menu bar with the following menu choices.

File Advanced Mode

Sets Advanced Mode on, displays expanded menu bar, and displays a log file of
installer actions that have occurred (for using during or after installation).

Database Update Database

Launches the Update Database Settings dialog. Use this to update your database
connection string post-installation.

Settings Sync Web Server Settings

Restarts the Intel EMA Web Server to apply/sync changes to web server settings.

Fix Settings Issues

Checks the server settings in the Intel EMA database. If any server settings are missing,
it will add the missing ones with the default values. This process is also automatically
performed during an Intel EMA version update install.

Switch from LDAPS to LDAP

Sets the LDAP ports Intel EMA uses to the standard non-secure ports. Intel EMA version
1.5.0 and later uses LDAPS secure ports by default (LDAPS secure port 636 and Global
Catalog port 3269). Previous versions of Intel EMA used the standard non-secure LDAP
ports (LDAP port 389 and Global Catalog port 3268). If you are installing Intel EMA v
1.5.0 or later, and are using Active Directory or 802.1x integration, ensure the LDAPS
ports are enabled. If you prefer to use the standard non-secure ports, then after
installing Intel EMA, open the installer program again (EMAServerInstaller.exe, run as
administrator) and select File > Advanced Mode, then click Settings > Switch from
LDAPs to LDAP to reset the LDAP ports Intel EMA uses to the standard non-secure
ports. Alternatively, you can change the ports in the Web server settings on the Server
Settings page in the Intel EMA UI. If you experience problems with 802.1x setup during
Intel AMT provisioning, this could be the issue. See the following link for more
information: https://docs.microsoft.com/en-us/troubleshoot/windows-
server/identity/config-firewall-for-ad-domains-and-trusts.

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
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Switch from Windows AD to Azure AD

IMPORTANT! It is HIGHLY recommended that you perform a backup of the Intel
EMA database BEFORE using this command. The switch cannot be undone, but
you can manually restore your database from the backup if you decide you want
to reverse this action.

Updates internal Intel EMA settings to switch this instance of Intel EMA from Windows
AD authentication to Azure AD authentication. You will be prompted to create a new
root Global Administrator account. For the username you can specify a username of an
existing Global Admin account, or you can choose to create a new username for the
root Global Admin account. You must provide a password to use with this root Global
Admin account, and all future logins to Intel EMA with this account will use
username/password to login.

After using this switching tool, restart the Web Server (or recycle the application pool)
for each Intel EMA website on each machine on which the Web Server is installed (note
that it is not sufficient to simply restart the web site). Use IIS Manager to do this.

After using the switching tool and restarting the Web Servers in IIS, go to the Intel
EMA login page and refresh the page at least twice. At this point the Azure AD
SSO login option should be displayed.

Notes:

l You MUST have Intel EMA v1.9.0 or later installed in order to use this
option. In a distributed environment, all Intel EMA server machines must
be updated to v1.9.0 or later.

l The current Authentication Type must be Windows AD, not local (normal)
accounts.

l Any existing Windows AD users that are not in your Azure AD tenant will
no longer be able to login to Intel EMA after the switch.

l You will not be able to add users and other Intel EMA actions until you
perform the steps in section 1.3.4 in Azure AD.

l Intel EMA instances configured to use Azure AD authentication do not
support individual user authentication via the REST API from scripts or
outside applications. Use of Client Credential authentication is a
supported alternative on these instances. If you require the use of
integrating applications or administrative scripts that call Intel EMA’s
APIs, verify that they will work with Azure AD authentication before
proceeding with a production deployment.

Actions Setup Firewall Rules

Runs the portion of the installer that handles firewall rule configuration.

Clear Firewall Rules

Runs the portion of the uninstaller that resets firewall rules.

IIS Registration

Runs the Microsoft.NET aspnet_regiis.exe

Dump all features to file

Writes the enabled Windows features to a file, and writes disabled Windows features to
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another file.

Check Common Names

Displays the hostname, FQDN, IP addresses of this machine.

Check Software

Displays IIS version, .NET CLR version, OS version, .NET framework.

Domain Detection

Detects what domain the system running the installer is part of.

Download disallowed password list

Downloads the current disallowed password list.

Upload disallowed password list

Allows user to upload a new disallowed password list.

Note: File format must be UTF-8 encoded text file, with newline delimiter
separating each disallowed password.

Lock/Unlock local global admin account

Enables or disables the local Global Administrator account (global root account), so that
it cannot login to the Intel EMA Web UI or Platform Manager when disabled. The
account is not removed, and can be re-enabled in the future. This option is only
applicable to installations using Azure AD authentication.

Uninstall the Intel EMA Server

Uninstalls the Intel EMA server.

Manager Launch Intel EMA Platform Manager

Launches the Intel EMA Platform Manager

Help Intel Support

Opens the Intel support portal in a web browser.
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3 Using the Global Administrator Interface
Intel® EMA’s Global Administrator pages are used to manage tenants, users, and user groups.

To login to Intel EMA, do the following:

1. Open a browser and navigate to the FQDN/Hostname you specified during installation.

2. At the login page, enter the user name (i.e., email address) and password for the Global Administrator.
Note: If you specified domain authentication, the Global Administrator Overview page is auto-
matically displayed.

3. At the bottom of the Overview page, under Getting Started, click View Getting Started tips.

4. On the Getting started page, follow the steps (in order) to Create a Tenant, Add a Tenant Administrator,
and then Add Additional Users (if desired). Note that you MUST create at least one Tenant Administrator for
each Tenant you create. The Global Administrator cannot perform many of the tasks in Tenants.

Note: In order to perform the Tenant setup tasks as described in the section 3 of the Intel® EMA Admin-
istration and Usage Guide, you must be logged in as the Tenant Administrator user of that Tenant. See the
Intel® EMA Administration and Usage Guide for details.

Logging out

To log out, click the user name in the top bar of the Overview page and select Log out.

3.1 Changing the Global Administrator Password
This operation can only be performed if “normal accounts” or Azure AD authentication mode was selected during
installation.

In the top right of the title bar, click the circle showing the first two letters of the Global Administrator user name and
select Change password.

3.2 Creating and Deleting Tenants
To create a new Tenant, do the following:

1. From the Overview page, click Create a tenant under Tenants at bottom left. Or, from the Getting started
page (available by clicking View Getting Started tips on the first page), select the Create Tenant.

2. Enter a Tenant Name and Description, then click Save.

To delete a Tenant, select the Tenants tab on the Users page, then click the down-arrow at right for the target
Tenant and select Delete Tenant….

3.3 Managing Users and User Groups
To manage users or user groups, you must first select a target tenant. New users (except for a new global
administrator) and user groups are created under this target tenant.

3.3.1 Adding, Modifying, and Deleting User Groups
To create a new User Group, do the following:

1. From the Users page (available from the navigation bar at left), select the User Groups tab and click New
Group.

2. In the New Group dialog, enter a Group name, Description, and specify Access Rights, then click Save.

To delete a user group, go to the User Groups tab of the Manage Tenants & Users page, click the down-arrow for
the target user group and select Delete Group....
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3.3.2 Adding, Modifying, and Deleting Users
To add a user, do the following:

1. From the Overview page, click Add or remove users under Users at the bottom. Or, from the Users page
(available from the navigation bar at left), select the Users tab.

2. Select which tenant to manage users for, and click New User.

3. In the New User dialog, enter a valid email address for User name, then enter a Password (and confirm),
and Description.

4. Select a Role for this user and click Save.

To delete a user, go to the Users tab of the Manage Users page, click the down-arrow for the target user, and select
Delete....

Notes:

l The last Global Administrator user cannot remove its account, nor edit it.

l If you configured Intel EMA to use Active Directory authentication, ensure the username of any user
you create corresponds to the userPrincipalName attribute of the Active Directory user. The
Password field is not shown or needed in this mode.

l If you configured Intel EMA to use Azure AD authentication, you cannot delete the initial account that
you created during installation, nor can you edit the role for this account. You can, however, edit the
password for the initial account. Furthermore, ensure the username of any user you create matches
the Universal Principle Name (UPN) of the Azure AD user. The password field is not shown or
needed in this mode.

l If you have configured Intel EMA to use normal (username/password) authentication, when creating
a new user or while updating the password for an existing user, the password will be checked based
on the password policy. The password policy can be configured by the global admin using Settings
in the Security Settings. By default the password policy will require min length 8, max length 255,
require complexity (uppercase/lowercase/number/special character) and will be checked against a
disallowed password list.

To edit a user, go to the Users tab of the Manage Users page, click the down-arrow for the target user, and select
Edit....

If you are editing your own user account, in order to change the password, you will need to enter your current
password first. If you are editing other accounts (that your role can manage), you do not need to enter the user’s
current password.

For “locked” users, use the Edit option to unlock the user’s account.
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4 Performing Intel® EMA Server
Maintenance
Use the Intel EMA Platform Manager to monitor each Intel EMA server and perform various maintenance tasks on
the component servers running on the Intel EMA server machine. You can also use it to deploy a new Intel EMA
component server package. In a distributed server architecture environment, a Platform Manager client on one Intel
EMA server machine can connect to and monitor the server components on the other Intel EMA server machines.

Notes:

l Be sure to change the user account under which the Platform Manager service runs. See Section
1.4.17 for details.

l Intel recommends following security best practices, including installing Platform Manager in the
suggested default location. Otherwise, be sure to install and run Program Manager in a system
privileged folder on the target system.

4.1 Manually Installing Platform Manager
The Platform Manager tool is installed as part of the Intel EMA server installation. However, if necessary, you can
install it manually by opening the Intel EMA installation media and running the Platform Manager installation file
PlatformManager.msi (be sure to run as Administrator).

You can use this method to install a standalone Platform Manager client on a Windows-based machine separate
from the one on which the Intel EMA server is installed, then remotely connect from the standalone Platform
Manager client to the existing Platform Manager server on the Intel EMA server machine.

Additionally, you can use this method to reinstall the Platform Manager server in the event that it gets accidentally
uninstalled. This assumes that all other Intel EMA components are still installed in C:\Program Files
(x86)\Intel\Platform Manager and that you reinstall Platform Manager to the same location.

4.2 Configuring the Intel® EMA Platform Manager
Service
Before using the Platform Manager, review this section and decide if you want to modify any default settings. All of
the configurable values are in the file C:\Program Files (x86)\Intel\Platform Manager\Platform Manager
Server\settings.txt.

4.2.1 Platform Manager TLS Certificate
The Platform Manager Service provides the TCP TLS connection between the service and the client application. A
default certificate for this TLS connection is provided with the Intel EMA installation, but this default certificate can be
updated to a certificate from a reputable certificate authority by updating the “certhash” value in the settings.txt file
with the thumbprint of the TLS certificate you want to use.

4.2.2 Mutual TLS Certificate for Client Authentication
The Platform Manager Service can optionally require that Mutual TLS be used in the connection between the
service and client applications. To enable this, update the “allowedclientcert” value in the settings.txt file with the
client certificate thumbprint. Multiple client certificates are supported by adding multiple “allowedclientcert” lines.

When you enable this feature, only clients providing a certificate which corresponds to one defined in the
“allowedclientcert” list will be allowed to connect.
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4.2.3 Kerberos with Active Directory in a Distributed Server Installation
If you are using Kerberos and Active Directory in a distributed server installation, then to connect the Platform
Manager service without having to make multiple HOST file entries on the servers and restart the Platform Manager
service on each, ensure the load balancer has been added as a Service Principal Name (SPN) for the computer
account in Active Directory. For more information on SPNs see the following
link: https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-checklist-for-kerberos-
authentication/ba-p/347639

4.3 Using the Intel® EMA Platform Manager Client
Application
Once you have configured the Platform Manager service, you are ready to start using the Platform Manager client
application.

4.3.1 Starting Intel EMA Platform Manager

Note: If you are using Intel EMA in a Microsoft Azure AD authentication environment, before performing the
steps in either section below, ensure that the Microsoft Edge WebView2 Runtime component is installed.
Some versions of Windows have this component preinstalled. If WebView2 is not installed, click the link
below and follow the instructions to download and install it before performing the steps to start Platform
Manager.

https://developer.microsoft.com/en-us/microsoft-edge/webview2/

4.3.1.1 From the Intel EMA Installer

When you launch Platform Manager from the Intel EMA installer, the installer automatically detects the Intel
EMA server connection information as well as your login authentication method.

1. Run the Intel EMA installer EMAServerInstaller.exe (run as Administrator) and click the Launch Intel
EMA Platform Manager button.

2. If you are using Windows Authentication, the connection credentials are automatically detected and used,
and the Platform Manager window is displayed with the application servers shown in the left-hand pane.

3. If you are using Azure AD authentication or Intel EMA credentials, the Connection Credentials dialog is dis-
played, with the detected authentication method selected. Click Next to complete the Azure AD sign on pro-
cess or enter Intel EMA user credentials for the Global Administrator user.

4. The Intel EMA Platform Manager window is displayed, with the application servers shown in the left-hand
pane.

5. To connect to additional servers (in a distributed installation), click Connect to Server....

4.3.1.2 From Windows

Follow the steps below to start Platform Manager from Windows (i.e., the Start Menu or Windows Explorer, etc.).

1. Start the Intel EMA Platform Manager application like any other Windows desktop application.

2. If this is the first time launching Platform Manager, click Connect to Server... at the bottom of the screen.
Otherwise, if you have previously saved connection and authentication information in a Platform Manager
solution file, you can select File > Load Solution from the menu bar and choose which file to load (see sec-
tion 4.3.2 below). If you loaded a file, enter any required credential information and skip to step 12.

3. In the Connect to Platform Manager Server dialog, enter the identifier (hostname/FQDN/IP Address) and
port for the Intel EMA Platform Manager server. If you are on the same machine as the Intel EMA component
servers, use the localhost:port value. In a distributed server architecture environment, if using Active Dir-
ectory, ensure all computers (including the load balancer host) are in Active Directory.

https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-checklist-for-kerberos-authentication/ba-p/347639
https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-checklist-for-kerberos-authentication/ba-p/347639
https://developer.microsoft.com/en-us/microsoft-edge/webview2/
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4. Enter the Intel® EMA Web Server Identifier. This is the hostname/FQDN/IP Address you use to open the
Intel EMA website.

5. If you configured the service for Mutual TLS, select a Client Authentication Certificate.

6. Click OK.

7. If prompted, verify and Accept the Server Certificate.

8. In the Connection Credentials dialog, select the connection method: Intel EMA Credentials, Azure
AD Authentication, or Windows Authentication.

9. For Intel EMA Credentials, enter the username and password for the Global Administrator user.

10. If you are using Windows Authentication, you may get an error connecting to the Intel EMA server. Check to
ensure you entered the correct identifier for the Platform Manager server above, and that the Intel EMA
server is up and running.

Notes:

l If you are using Windows Authentication, ensure the system running Platform Manager is
joined to the domain, and that the Global Administrator account you are using is logged into
the domain. Otherwise you will be prompted for credentials.

l If you are using Kerberos and Active Directory in a distributed server installation, then to
connect the Platform Manager service without having to make multiple HOST file entries on
the servers and restart the Platform Manager service on each, ensure the load balancer has
been added as a Service Principal Name (SPN) for the computer account in Active Directory.
For more information on SPNs see the following
link: https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-
checklist-for-kerberos-authentication/ba-p/347639

11. For Azure AD Authentication, you will be prompted for your Azure AD Single Sign On (SSO) credentials.

12. The Intel EMA Platform Manager window is displayed, with the application servers shown in the left-hand
pane. If the screen prompts you to Connect, check to ensure you entered a user with Global Administrator
rights in the Connection Credentials dialog. To connect to additional servers (in a distributed installation),
click Connect to Server... again.

13. When you exit Platform Manager, if you changed server connection information, you will be prompted to
"save solution". You can save the connection and authentication method information to a file and then load
that information from the file by using the File > Load Solution menu choice the next time you start Platform
Manager. See section 4.3.2 below.

4.3.2 The File Menu

Load
Solution

Loads the server connection information from a previously saved file. Launches the Connect to Platform
Manager Server dialog with all information pre-filled except for passwords. For Windows and Azure AD
authentication, you will be prompted for sign on credentials.

Save
Solution
(as...)

Saves the current server connection information to a specified file. This file can then be loaded the next
to you start Platform Manager. Passwords are not saved in the connection information (i.e., solution) file.

Add
Server

Launches the Connect to Platform Manager Server dialog for you to enter connection information and
credentials.

Add
Group

Launches the Create Group dialog, where you can group multiple server connections.

Log Displays the Platform Manager log file.

Exit Exits the Platform Manager client application.

https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-checklist-for-kerberos-authentication/ba-p/347639
https://techcommunity.microsoft.com/t5/iis-support-blog/service-principal-name-spn-checklist-for-kerberos-authentication/ba-p/347639
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4.3.3 Monitoring Component Server Events
1. Select a component server from the list in the left-hand pane (for example, the EMAAjaxServer).

2. Select the Events tab to see the events for that server. Events are also logged in C:\Program Files (x86)\In-
tel\Platform Manager\EMALogs\EMALog-[server type].txt on the selected server machine. Note that the log
file contains more detail than what is displayed on the Events tab.

3. If desired, click Trace at the bottom of the panel to enable detailed debugging tracing (this will result in a lot
more messages being logged). The trace log is also logged in C:\Program Files (x86)\Intel\Platform Man-
ager\EMALogs\TraceLog-[server type].txt.

Note: The trace file will not be present if tracing is not enabled for the selected component server.

4.3.4 Monitoring Component Server Internal Tracking Information
1. Select a component server from the list at left.

2. Select the Component tab to display useful information for the selected component server. Different com-
ponent servers have different tracked values, as described below.

Intel EMA AJAX server:

l AjaxSessions: Number of active AJAX request sessions issued by Intel EMA JavaScript library, which are
process by the AJAX server.

l HttpSessions: Number of HTTP sessions (used for web redirection features) issued by Intel EMA JavaScript
library, which are process by the AJAX server.

l SwarmSessions: Number of active TCP connections to the Swarm server from the AJAX server.

l WebSocketSessions: Number of active Web Socket sessions issued by Intel® EMA JavaScript library,
which are process by the AJAX server.

Intel EMA Manageability server:

l Each row is a slot to be used for Intel AMT provisioning. A pending Intel AMT provisioning request is put into
an available slot. The Manageability server starts the provisioning for all the slots individually. If there is no
slot available, the request awaits for an available slot to open. The row displays the information text of Intel
AMT provisioning.

Intel EMA Swarm server:

l ConAgents: Number of active Intel EMA Agent’s TCP connections to the Swarm server.

l ConConsoles: Number of active TCP connections from other Intel EMA servers.

l ConIntelAmt: Number of active Intel AMT CIRA connections to the Swarm server.

l DbFails: DB queries’ failure count made by this Swarm server.

l DbQueries: DB query count made by this Swarm server.

4.3.5 Performing Basic Controls on Component Servers
To halt/stop or resume an component server, right-click the server in the left-hand pane and select the desired
option.

To see the available control commands for a particular component server, select a server and go to its Console tab,
then type “help” and click Send. The commands are listed below.

All servers:

l testmessage: This sends out test blast messages via TCP connections between Intel EMA components. You
should see the Received test blast from: [source server] message in the Events tab of the AJAX server, Man-
ageability server, and the Swarm server.

l echo: Print back what you typed.

l time: Print the current server machine time.
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l utctime: Print the current server machine time in UTC.

l version: Print the component version.

l shutdown: This will let you shutdown/halt this server; however, it will be re-launched soon after.

l collect: Trigger .NET garbage collection.

l whoami: Print the current account this server runtime is running under.

l logpath: Print the log folder path.

l trace: Lets you start/stop tracing info being logged in a trace file. The trace file is in the path specified by log-
path.

l restart: Restarts the server.

Intel EMA AJAX server:

l stats: Print the "tracked values", same as what Application tab shows.

l testdb: Test connection to Intel EMA server DB.

l ajaxcert: Print information about the inter-service TLS ajax certificate.

l swarmsessions: Print the current swarm sessions.

l alertsessions: Print the current alert sessions.

l dbcount: Control DB trace counting.
l Start: This starts to collect the database SQL commands info, run by the Swarm server. It includes
the collection start time, the collection duration, and the total number of DB connections made by
Swarm server. For each SQL command item, it includes the execution count, the error count, the total
running time, and the SQL command. Note that our SQL commands are designed to use para-
meterized inputs. Therefore, we only log the parameter name here, not the value.

l Save and Restart: Save the collected data to the EMALogs folder in the Intel® EMA server install-
ation folder.

l Cancel: Cancel the data collection and do not save anything to file.

l mcount: Print the count of different types of test blast messages sent via TCP connections between Intel
EMA components.

Intel EMA Manageability server:

l testdb: Test connection to Intel EMA server DB.

l exec: This triggers the Manageability server to check Intel EMA server DB to find any Intel AMT provisioning
work to be done immediately. Otherwise, Manageability server checks that periodically.

l restart: Restart the Manageability server.

l dbcleanup: Performs on-demand database maintenance routine. See Section 4.7 for details.

l slots: Print activation tasks' slots. Manageability server currently is performing internal throttling. It can do at
most concurrent 20 provisioning tasks (slots). For the remaining provisioning tasks, they will wait in the
Intel® EMA sever DB to be picked up later.

l manageabilitycert: Displays information about the inter-service TLS manageability certificate.

l fileuploadcleanup: Performs on-demand clean up to remove expired USBR temporary files.

l cert8021xrenewal: Performs on-demand certificate renewal for expiring 802.1x certificates.

Intel EMA Swarm server:

l stats: Print
l The incoming traffic from Intel EMA Agent in bytes, the outgoing traffic to Intel EMA Agent in bytes.

l .Net Garbage Collector: GetTotalMemory’s value. Intel EMA DB queries count, connections count,
DB queries failure count made by this Swarm server.

l Connected Intel EMA agent counts.

l The number of received blast messages, the number of sent blast messages.

l Intel EMA server DB schema version.
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l testdb: Test connection to Intel EMA server DB.

l swarmcert: Display information about the inter-service TLS swarm server certificate.

l servercert: Display information about the Intel EMA swarm server certificate.

l resetagentstore: Sync the in-memory agent installers information based on the available Intel EMA agent
installers in Intel EMA DB. Then it checks the agent download and agent upload for each connected Intel
EMA agents.

l forcedisconnect: This will disconnect this target endpoint for now. The endpoint can still connect back.

l dbcount: Control DB trace counting.

l consoles: This lists the current connected Intel EMA application servers. For example, when you do a
"remote terminal" session, there will be 1 console session between AJAX Server and Swarm server.

l dbschema: Print the Intel EMA server DB schema version.

l allownode: Add an endpoint to pass list. When Swarm server gets an Intel EMA agent connection request, if
there exists a non-empty endpoint banned list, it will check it. If this incoming agent/endpoint is banned, it
will reject the connection.

Note: The current Intel EMA release does not implement this feature.

l bannode: Add an endpoint to banned list.

l clearnodeaccess: Clear the banned and pass list in memory. It will be reloaded when Swarm server starts
again.

l nodeaccesslist: Print the endpoint white/banned list.

l ipblocklist: When Swarm server gets an Intel AMT CIRA or Intel EMA agent connection request, if there
exists an non-empty IP block list, it will check it. If this incoming IP address is in the same subnet as specified
in the IP block list, it will reject the connection.

Note: The current Intel EMA release does not implement this feature.

l swarmid: Print the this Swarm server's id and the lead Swarm server's id. This is useful when you have mul-
tiple Swarm servers under load balancer. The leader is usually the Swarm server just started recently and
with highest ID.

l agentpingtime: Print the current ping time for maintaining Intel EMA agent TCP connection. If you provide a
numerical argument, it will set the ping time to this value in seconds.

l agentrequireping: Print if we need all the Intel® EMA agents to respond with a pong to a ping sent by the
Swarm server. 1 is true, and 0 is false. If this setting is true, then the Swarm server will drop the agent TCP
connection if a pong is not received. If you provide an argument (1 or 0), you can set the value.

l ignoredupagents: By default, this is disabled. When the Intel EMA Swarm server receives an incoming Intel
EMA agent connection, if this connection has an endpoint ID that is the same as an existing connection,
then we will disconnect and remove the existing connection and accept the new one. However, if this is
enabled, we will do nothing and just ignore the new incoming connection. This prints 1 or 0. 1 is true/en-
abled, and 0 is false/disabled. If you provide an argument (1 or 0), you can set the value.

l swarmpeers: Print the other peer Swarm servers' IDs and IP addresses.

4.4 Deploying New Packages
A package is a zip file containing a component server or website. An Intel EMA release contains several packages.
Packages are located in the StoredPackages folder in your Intel EMA release.

Note: If you have an older version of Intel EMA, you can use Platform Manager to upload and deploy newer
versions without touching your Intel EMA database. However, if the new release includes Intel EMA data-
base changes, then you must still use the Intel EMA installer to perform an update.

To update a particular component server:
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1. In the left-hand pane, open Intel® EMA Servers and select a machine from the list (for example, localhost).

2. Select the Storage tab.

3. Click Upload and select the .zip package (for example, EMASiteCoreReact.zip) you want to deploy to that
machine. The old version is replaced with the new version in the Component Packages list.

4. Click Deploy to deploy the new package on the selected machine.

4.5 Updating the Database Connection String
Note: Two database accounts are required: one of the installer which requires DB Owner permissions, and
one for the Intel EMA services, which allows the database service to be run with lesser privileges.

To update the database connection string after installation, do the following:

1. Run the Intel® EMA Installer Wizard (in the installation folder, right-click on EMAServerInstaller.exe and
select Run as administrator).

2. From the File menu, select Advanced Mode. Additional menus are displayed, including the Database menu.

3. From the Database menu, select Update Database. The Update Database Settings dialog is displayed.

4. To update the server or database name, or the SQL authentication user and password, simply enter new val-
ues for these fields and click Update. To enter a new customized database connection string, continue to the
next step.

5. Click the checkbox for Advanced Mode.

6. Enter a new Connection String for either connection string field, or both. For more information about con-
nection strings, see https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-
syntax. Note that some examples on this page may not be supported by Intel EMA.

Note: The parameter “MultipleActiveResultSets=True” is required. For more information, see
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets.

7. Click Update to update the connection string and close the Update Database Settings dialog.

Note:
l You must restart all Intel EMA component servers (i.e., Swarm Server, .Manageability Server, etc.) in
order for the new connection string to take effect.

l A copy of the previous connection string file c:\Program Files (x86)\Intel\Platform Man-
ager\Runtime\MeshSettings\connections.config is created.

l In a distributed server architecture environment, the connection string must be updated on all Intel
EMA server systems.

4.6 Revoking a Server's Certificate
In a distributed server architecture environment, there may be situations where you want to revoke an Intel EMA
server's certificate. For example, if you suspect a server has been compromised, or if you plan to decommission a
server.

The following certificates (installed in the Personal certificate store on the local Windows machine) can be revoked:

l Inter-component TLS certificates: These certificates are used for communication between Intel
EMA components (Ajax server, Swarm server, etc.), as well as between Intel EMA server machines in a dis-
tributed server installation. They can be identified by the value "EmaMtlsXXX" in the IssuedTo field, and the
value "MeshRoot-XXXX" in the IssuedBy field.

l Intel EMA settings certificates: These certificates are used to read the encrypted Intel EMA server settings
in the Intel EMA database. They can be identified by the value "MeshSettingsCertificates-XXX" in the
IssuedTo field, and the value "MeshRoot-XXXX" in the IssuedBy field.

https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/connection-string-syntax
https://docs.microsoft.com/en-us/dotnet/framework/data/adonet/sql/enabling-multiple-active-result-sets
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IMPORTANT! If you revoke the Intel EMA settings certificate on a single server installation (or on the last
server of a distributed server architecture), you will render the Intel EMA server inoperable. This cannot be
recovered and requires fully reinstalling the Intel EMA server using the installation wizard or the command
line installation.

The Intel EMA API provides an API called CRL, which stands for Certificate Revocation List. This API essentially
adds a certificate's serial number to a "blocklist" file of certificates known as a Certificate Revocation List.

To use this API to revoke a server's certificate, consult the Intel® EMA API Guide or review the API documentation
online in Swagger. Then use a tool like "cURL" to issue the CRL API commands at a command prompt window.

Note: The CRL API includes the option to restart the Intel EMA server components automatically (default) or
manually. The automatic option restarts all Intel EMA component servers (Ajax server, Swarm server, etc.),
including the IIS app pool that hosts the Intel EMA website. Note that any other websites in that app pool will
be restarted as well. The automatic option restarts all components on all servers in a distributed server archi-
tecture.

4.7 Periodic Database Maintenance
The Intel EMA database grows over time, which can eventually affect performance. Periodically, you should rebuild
the table indexes and clean up the database row file and log file to ensure optimal database performance. In
addition, there is an automated database cleanup utility, DBCLEANUP, that automatically runs periodically to
maintain specific tables such as the audit log table to remove old entries. See Section 6.3 for information on setting
the interval (Audit Log Cleanup Interval) to automatically run DBCLEANUP.

You can also run the DBCLEANUP command manually from the Manageability Server's Console tab in Platform
Manager. To do this, follow the steps below:

1. Run the Platform Manager (see Section 4.3.1 for details).

2. From the navigation pane at left, select Intel® EMA Servers > localhost > EMAManageabilityServer.

3. Select the Console tab.

4. In the Component Console window, enter the command dbcleanup at the prompt and press Enter.

4.8 Restoring the Intel® EMA Server from Backup
In Section1.4.1, we recommend that you back up your Intel EMA database and MeshSettingsCertificate after
installing Intel EMA. This section describes how to restore your Intel EMA server from that backup.

Note: These steps apply to a single server architecture installation. Further information on distributed archi-
tecture restoration is provided at the end of this section.

1. Start with a clean system.

2. Restore the database backup.

3. Restore the MeshSettingsCertificate certificate (including the private key) to the Local Machine/Personal loc-
ation of the Certificate Store. The access of the private key needs to be open for the account running the
Intel EMA components and the account running Intel EMA IIS website.

4. Run the Intel EMA Installer and choose Single Server setup, as described in Section "Installing or Updating
the Intel® EMA Server" on page 17. Be sure to point the installation to the restored database. The installer
will indicate that you are performing an update installation. This is normal.

5. In IIS Manager, check to ensure IIS bindings are correct. You should see information similar to the following:

Site bindings should be similar to this:
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For ports 443 and 8084, you should see binding details like this (with 443 or 8084 port):

For URL rewrite, you should see settings like this:
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For distributed environments, as long as you have at least on machine left with a healthy Intel EMA installation, you
can use that machine to set up additional Intel EMA server machines as described in section 2.2.2.

If you do not have any healthy machines left, follow the steps above to recover a single server first. Then use the
Server Settings GUI page (see Section 6) to adjust the server settings (Server IPs, Swarm server list) to match your
current situation.
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5 Appendix: Troubleshooting After
Installation
5.1 General Troubleshooting
Check logs, traces, or events The installation log file EMALog-Intel®EMAInstaller.txt is located in

the same folder as the Intel EMA installer (i.e., wherever you
downloaded and ran the installer).

Note: The following warning appears in the installation log file
regardless of whether you are installing with a local SQL Server
or a remote SQL Server. For installations with a remote
SQL Server, this message can be ignored. For local SQL server
installations, ensure the the account is set up to allow your IIS
Default Application Pool to connect.
EVENT: DbWarning, ExecuteNonQuerySafe warning:
CREATE LOGIN [IIS APPPOOL\DefaultAppPool] FROM
WINDOWS() - System.Data.SqlClient.SqlException
(0x80131904): User does not have permission to
perform this action.

Please see Section 4 of this guide for information on viewing the log
file, trace file, or events for each of the Intel® EMA component servers.

Intel® EMA Server Installation Error Intel® EMA Platform Manager Package path not set correctly

The installer can find an existing Platform Manager settings file (e.g.,
C:\Program Files (x86)\Intel\Platform Manager\Platform Manager
Server\settings.txt), but cannot find the Intel EMA packages (e.g.,
C:\Program Files (x86)\Intel\Platform Manager\Packages) listed in that
settings file.

To fix:

1. Uninstall the Intel EMA Server, selecting all options.

2. Ensure that Intel EMA Platform Manger is no longer installed
and there is no content in the Intel EMA installation folder (e.g.,
C:\Program Files (x86)\Intel\Platform Manager).

3. Re-install the Intel EMA Server.

Intel® EMA Platform Manager Service
not starting

Like all Windows services, the Intel EMA Platform Manager Service
will timeout if the service takes too long to start (30 seconds by
default). On slow machines, this timeout limit may be reached while
the Intel EMA Platform Manager Service is starting. If this happens Intel
EMA will not work correctly.

Check the status, events, and log of this service:

l In the Windows Services viewer, check to see if it is started suc-
cessfully.

l In the Windows Event Viewer, go to Windows Logs \ System
and look for entries with Level: Error and Source: Service Con-
trol Manager.

l If this service has exceptions thrown, you can find them in the
log file, PlatformManagerError.txt, on your Windows drive (e.g.
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C:\PlatformManagerError.txt).

To fix:

Change the Windows registry settings to modify this timeout value. We
recommend doing an internet search for “Error 1053
ServicesPipeTimeout” for information on how to do this.

Error when trying to access the Intel®
EMA website

Ensure the website is deployed. The website may not be deployed
due to the package path issue mentioned above.

To fix:

Use Windows IIS Manager to determine the folder of the Intel® EMA
website (click Explore under Actions, top right). In that folder you
should see many subfolders and files.

If not, use the Platform Manager to “sync site” and redeploy the
website.

The target Intel® EMA website URL
must match the Intel® EMA website’s
certificate

If the URL used to access the Intel EMA website does not match the
Issued to field of Intel EMA website certificate, the web browser’s
security filtering will block many features.

To fix:

Ensure Intel EMA URL matches the Issued to field of the certificate.
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Warnings and errors during Intel®
AMT setup/provision

Depending on the target Intel® AMT firmware’s status, some of the
warnings/errors may be transient errors. The Intel EMA Manageability
server will automatically re-try the failed setup periodically. However,
some of the warnings/errors are valid and need to be addressed.

Note: Refer to the Platform Manager section of this guide for
information on warnings and error messages logged by the
Manageability server during the setup/provision process.

Transient warnings/errors that can be ignored

Warning/Error type – OTP_REQUIRED:

Message:Host Based Admin Setup (1st try): OTP_
REQUIRED

Message:Unable to go to admin mode, rolling back out
of client mode.

Warning/Error type – INTERNAL_ERROR due to Unauthorized
WSMAN call:

Message:Creating DotNetWSManClient object...

Warning:Error (2):
Intel.Manageability.WSManagement.WSManException:
The remote server returned an error: (401)
Unauthorized.

Message:Host Based Setup (1st try): INTERNAL_
ERROR

Note: The server will re-try the installation despite these errors
until the third try.

Valid warnings/errors that must be addressed

PKI domain suffix not matching the PKI certificate:

Warning/Error type – Message:Host Based Admin Setup
(3rd try): AUTH_FAILED

Warning/Error type – Message:Unable to go to admin
mode, rolling back out of client mode.

INTERNAL_ERROR due to Intel® Management and Security
Application Local Manageability Service (LMS) not running correctly:

Warning/Error type – Warning:Error (2):
Intel.Manageability.WSManagement.WSManException:
The underlying connection was closed: The connection
was closed unexpectedly.

Warning/Error type – Message:Host Based Setup (3rd
try): INTERNAL_ERROR

WSManException due to Intel AMT FW requiring a reset:

Warning:Error (2):
Intel.Manageability.WSManagement.WSManException:
The underlying connection was closed: The connection
was closed unexpectedly. --->
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System.Net.WebException: The underlying connection
was closed: The connection was closed unexpectedly.

If this does not resolve after the Intel® Manageability
Server retries the setup, then shut down the Intel® AMT
machine, unplug the power cable and unplug the
Ethernet cable to reset the Intel® ME firmware. Then
reconnect the cables back and restart the machine.

Error due to full certificate store in Intel® AMT FW:

Error: .[omitted]….. Certificate Store in firmware is full
and no more certificates can be added.

In this case, we suggest to unprovision this Intel® AMT
system. Then use Intel® EMA’s manual provision or
auto provision to set up this system again.

Intel® AMT operation does not work,
but all other features function correctly

This section applies to the scenario where Intel EMA server is installed
under Use hostname only mode and the target endpoint is
provisioned with Intel AMT CIRA.

If Intel AMT operation does not work, but all other features work, it is
very likely that the Intel AMT CIRA firmware cannot resolve the
hostname/FQDN entered during Intel EMA server installation.

To fix:

1. Unprovision the target endpoint.

2. With a clean setup and a clean/unprovisioned endpoint, per-
form a CIRA provision and monitor the provision events.

a. To monitor, go to the EMAManageabilityServer’s
Events tab in Platform Manager. Make sure there are
no errors (a few warnings are OK).

b. On the target endpoint, open the Intel® Management
and Security Status Tool and go to the General tab. If
the provision is successful, you should see two events:
Configured and Remote Control Connection is
Enabled.

c. If the provision was successful, continue with the
remaining steps. Otherwise, check the event and logs of
the Intel® Manageability server and fix the issues.

3. On the EMASwarmServer’s Component tab (in Platform Man-
ager), monitor the ConIntelAmt value. This is the number of act-
ive CIRA connections. If you provisioned one endpoint with
CIRA and CIRA successfully established the connection to Intel
EMA Swarm server, this value should be 1. If this number is not
correct, restart the target endpoint and wait for one to two
minutes. If the ConIntelAmt value is still incorrect, continue with
the remaining steps.

4. At this point, Intel AMT CIRA firmware probably cannot resolve
the hostname/FQDN. To verify this, use the fixed IP address
mode to do a provision. If fixed IP address mode works, then
the root cause is due to the name resolution issue. In that case,
consult your IT administrator. Follow these steps to temporarily
use the fixed IP address mode:

a. On the Server Settings page, change the ciraserver_ip
setting of the Manageability server (see "Appendix -
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Modifying Component Server Settings" on page 70).

b. Save settings are restart the Manageability server.

5. Unprovision the target endpoint and re-perform the provision.
This time, CIRA will use the IP address you specified above.

Uninstalling Intel® EMA server fails to
drop the database

When uninstalling the Intel EMA server, you may see the
warning/error: “Unable to drop database.”

To fix:

1. Open Microsoft SQL Server Management Studio and connect
to your database, then check the existing databases.
Determine whether the Intel EMA database is set to “Single
User” mode.

2. Right click the target database and choose Delete. Do not
change any default values in the Delete option window. Delete
the target database.

3. If the database is not deleted, right-click the database server
and choose Restart. After the database server is restarted, try
to delete the target database again.

802.1x setup fails during Intel AMT
provisioning

-OR-

Active Directory user validation fails
after updating to v1.5.0 or later

-OR-

Active Directory option not available
during installation or update to v1.5.0
or later

Intel EMA version 1.5.0 and later uses LDAPS secure ports by default
(LDAPS secure port 636 and Global Catalog port 3269). Previous
versions of Intel EMA used the standard non-secure LDAP ports
(LDAP port 389 and Global Catalog port 3268). If you are installing
Intel EMA v 1.5.0 or later, and are using Active Directory or 802.1x
integration, ensure the LDAPS ports are enabled. If you prefer to use
the standard non-secure ports, then after installing Intel EMA, open the
installer program again (EMAServerInstaller.exe, run as administrator)
and select File > Advanced Mode, then click Settings > Switch from
LDAPs to LDAP to reset the LDAP ports Intel EMA uses to the
standard non-secure ports. Alternatively, you can change the ports in
the Web server settings on the Server Settings page in the Intel
EMA UI. If you experience problems with 802.1x setup during Intel
AMT provisioning, this could be the issue. See the following link for
more information: https://docs.microsoft.com/en-
us/troubleshoot/windows-server/identity/config-firewall-for-ad-
domains-and-trusts.

See section 6, "Appendix - Modifying Component Server Settings" on
page 70

Intel EMA agents fail to connect to
server after updating to v1.4.0 or later

This may be due to disabled TLS cipher suites. As of v1.4.0, Intel EMA
restricted the usable TLS ciphers suites for the agent while leaving the
older cipher used by Intel AMT enabled for CIRA. Check to ensure
proper TLS cipher suites are enabled. See sections 1.4.6 and 1.4.7 for
more information.

Note: This issue has been consistently observed in Windows
Server 2022 installations due to default settings in the OS.

Error processing MeshSet-
tingsCertificate during update install-
ation

During an update installation, the installer will fail with an error
message "Missing, invalid, or multiple MeshSettingsCertificates found"
under the following circumstances:

l No MeshSettingsCertificate was found in the Intel
EMA database

l The MeshSettingsCertificate was found, but it is corrupted or in

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts


Intel® EMA Server Installation Guide - Tuesday, November 21, 2023

68

an invalid format

l Multiple MeshSettingsCertificates were found in the Intel
EMA database

To fix:

To fix this problem, restore the last known good copy of the
MeshSettingsCertificate to the Intel EMA database from backup. Be
sure to remove any invalid or additional copies of the certificate before
restoring from backup. See section 4.8 for information on restoring
from backup.

Exporting PFX using Server Cer-
tificates API fails

Periodically, calling the POST /api/latest/serverCertificates/{cer-
tificateName}/getPFX will result in an error. If this occurs, wait for a
minute and then retry the call again.

5.2 Distributed Server Installation Troubleshooting
Server components (Swarm, Ajax, etc.) do
not appear to be connecting to each other
across machines

Check the following:

l Load Balancer: Ensure your load balancer is configured
properly per its documentation. Specifically, ensure that
health checking rules and traffic forwarding rules include
ports 443 (front-end), 8084 (front-end), and 8080 (agent
and Intel AMT CIRA connections). For ports 443 and
8084, traffic forwarding rules must have session per-
sistence (stickiness) enable.

l Firewall and Network Ports: Ensure your firewall rules
have the required ports set to Open. See "Server network
ports" on page 6. Also check any other network security
rules for your environment.

l Server Settings: On the Server Settings page of the Intel
EMA UI, check the following for each component server:

l Server IP addresses: ensure the correct list of
IP addresses is shown for each type of com-
ponent server.

l Message Port: This is the port that this component
server type is listening on for inter-component
messages. If you changed this in Server Settings,
make sure the new port is not blocked by a fire-
wall.

l Swarm Server list: Ensure the correct list of "
[Machine ID]:[Machine IP Address]" pairs for the
Swarm Servers in your distributed installation.
You can verify the Machine ID in the Intel
EMA database under the Server Settings table.
Then use the Machine Name to obtain the correct
IP Address for that machine.

l After verifying, test the components by starting
Platform Manager and running "testmessage" on
the Console tab of one of the Intel
EMA components. Each component should be
able to send out a blast message to all other com-
ponents (including itself) on all machines in the
distributed installation. Verify the reception of the
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messages in the Events tab of each component
on each machine.

Authentication fails intermittently Ensure that all Intel EMA websites in the distributed environment
are using the same machine keys. Verify this using IIS Manager
on each machine where the Intel EMA website is hosted. See
Section 2.2.1.11.

From one of the machines in a distributed
server architecture installation:

l Platform Manager client cannot con-
nect to the Platform Manager service
-OR-

l Cannot open the Intel EMA UI in a
browser

In a distributed environment, if you install Intel EMA under
Kerberos (Windows Authentication), the Platform Manager client
may have difficulty connecting to the Platform Manager service
from one of the distributed server machines. Similarly, you may
have difficulty opening the Intel EMA UI in a browser from one of
the distributed server machines.

This is due to the Service Principal Name (SPN) for the load
balancer not being configured correctly in Active Directory.

To fix:

To fix this problem, ensure your SPN for the load balancer is
correctly configured.

Also, you can use one of the other server machines' FQDN for
the target URL, not the load balancer's FQDN (the other machine
must have an Ajax or Web server installed). Doing so will allow
you to launch Platform Manager or browse to the Intel
EMA website from one of the server machines in your distributed
environment (i.e., a host managed by the load balancer),
regardless of the SPN configuration for the load balancer.

Note that from all other machines (i.e., systems not managed by
the load balancer), you can simply use the load balancer's
FQDN.
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6 Appendix - Modifying Component Server
Settings
The settings for the various component servers (Swarm Server, Ajax Server, etc.) that comprise the Intel EMA server
can be modified using the Server Settings tab, which is accessible from the Settings selection on the vertical
navigation pane at left. To modify security settings for the component servers, select the Security Settings tab. See
section 6.5 for a list of security settings and descriptions.

The following subsections describe the settings available for each of the component servers. For each component
server, settings are listed in the order they appear in the Intel EMA user interface pages.

Note: If you change the serverIps or messagePort setting for any of the component servers, you must restart
all the component servers, not just the one whose settings you changed (in a distributed server architecture,
you must do this on all server machines). Also, you will need to recycle the Intel EMA web site's IIS applic-
ation pool to restart the Intel EMA web server when you change these two settings. For other settings, restart-
ing only the modified component server will suffice. If you change messagePort, make sure the new port is
not blocked by a firewall.

6.1 Swarm Server
Setting Description
UI: Admin Port

API: adminport

The port that Swarm Server's Admin TCP listener will bind to. This is for com-
munication from other Intel EMA server processes to the Swarm server. The
default is 8089.

UI: Admin Port Local

API: adminportlocal

Determines if the Admin TCP listener will only bind to the local loopback or
not. Values are 0 and 1.

0 = Distributed-server environment

1 = Single server environment

UI: Agent Auto Update

API: enableAgentAuto
Update

Boolean. Enables or disables automatic agent update. Default: Enabled.

UI: Agent Update Interval (Seconds)

API: agentUpdateIntervalSeconds

Interval in seconds between Intel EMA Agent updates. I.e., if set to 5, the
Intel EMA server will wait 5 seconds before attempting to update the next
agent requesting update. Default: 10. Minimum: 10. Maximum: 120.

UI: Log File Path

API: logfilepath

Path to the Intel EMA logfile.

Maximum: 247 characters

Minimum: 2 characters

UI: Enable Intel CIRA Power State
Polling

API: enableCIRAPowerPolling

Enable periodic CIRA power state polling. Values are True/False. The
default is True.

UI: Maximum Number of Concurrent
Database Connections

API: maxdbconnections

The maximum number of concurrent DB connections for this server.

UI: Swarm Servers

API: swarmserver

List of active Swarm Servers. Includes Server ID and Server IP & Port
(format IP Address: port).
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Setting Description
UI: Server IPs

API: serverIps

List of machine IP addresses where this component server type is running.
For example, if the Swarm server is running on machine ip1, ip2, and ip3,
then serverIps will include all IP addresses.

UI: Message Port

API: messagePort

The TCP port this component server type is listening on to accept internal
traffic from other Intel EMA components. Default 8093.

UI: TCP Connection Retry

API: tcpConnRetrySeconds

Wait time between retries when establishing communication connections
between Intel EMA server components.

UI: TCP Connection Idle

API: tcpConnIdleSeconds

Interval between heartbeat messages sent between components once com-
munications are established.

UI: Database Connection Wait Time
(Minutes)

API: dbConnectionWaitTime
Minutes

Amount of time in minutes that Intel EMA will wait for getting a database
connection.

Range: 1 - 10

Default: 2

UI: Database Lock Timeout Period
(Seconds)

API: dbSetLockTimeoutSeconds

Amount of time in seconds that a SQL query will keep a lock.

Range: 1 - 60

Default: 2

UI: Database Retry Hold Time for a
Query (Milliseconds)

API: dbRetryHoldtimeMilli
Seconds

Amount of time in milliseconds that a SQL query will wait to complete. This
value is multiplied by the value of Database Retry Attempts for a Query to
increase the hold time in each retry.

Range: 100 - 60000

Default: 100

UI: Database Retry Attempts for a
Query

API: dbRetryMaxAttempts

Number of retries to execute a failed SQL query. After reaching this value,
the Swarm server will restart due to critical failure in the database.

Range: 3 - 100

Default: 5

UI: CIRA Keep-alive Interval
(Seconds)

API: CIRAKeepAliveIntervalSeconds

Sets the interval, in seconds, for the Swarm Server's periodic messages to
the target endpoint's Intel AMT firmware to keep the CIRA connection open.
New installations of Intel EMA will have a default value of 10 minutes.
Upgrading from an older version of Intel EMA, prior to 1.11.0, will have a
default value of 10 seconds.

Default: 10 seconds

Min: 10 seconds

Max: 1 hour (i.e., 3,600 seconds)

6.2 Ajax Server
Setting Description
UI: Ajax Cookie Auto Refresh
Range

API: ajaxCookieAutoRefreshRange

Range in minutes in which the Ajax cookie life can be extended.

UI: Ajax Cookie Idle Timeout

API: ajaxCookieIdleTimeout

Amount of time, in minutes, from when the cookie is added until it expires.
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Setting Description
UI: Http Header Access Control
Allow Headers

API: httpheader_Access-Control-
Allow-Headers

Additional headers to set in response to the Ajax request.

UI: Log File Path

API: logfilepath

Path to the Intel EMA logfile.

Maximum: 247 characters

Minimum: 2 characters

UI: User Access Failed Max Count

API: userAccessFailedMaxCount

Number of failed password attempts before user account is locked by the
Web API.

UI: Expire Sessions

API: expiresessions

Sets whether the Ajax server should expire the session or not (default is
enabled).

UI: Maximum Number of
Concurrent Database Connections

API: maxdbconnections

The maximum number of concurrent DB connections for this server.

UI: Server IPs

API: serverIps

List of machine IP addresses where this component server type is running.
For example, if the Ajax server is running on machine ip1, ip2, and ip3, then
serverIps will include all IP addresses.

UI: Swarm Servers

API: swarmserver

List of active Swarm Servers. Includes Server ID and Server IP & Port (format
IP Address: port).

UI: Message Port

API: messagePort

The TCP port this component server type is listening on to accept internal
traffic from other Intel EMA components. Default 8092.

6.3 Manageability Server
Setting Description
UI: CIRA Server Host

API: ciraserver_host

Hostname of the CIRA access server, which is the Swarm Server
(or the Swarm Server load balancer in a distributed
architecture). Only used when the installation mode is using
hostname. This is used in multi-server installations.

UI: CIRA Server IP

API: ciraserver_ip

IP Address of the CIRA access server, which is the
Swarm Server (or the Swarm Server load balancer in a dis-
tributed architecture). Only used when the installation mode is
using IP address.

UI: CIRA Server Port

API: ciraserver_port

The port of the CIRA access server, which is the Swarm Server
(or the Swarm Server load balancer in a distributed archi-
tecture). Used by the load balancer to direct incoming traffic
(from CIRA) to the Swarm Server's 8080 port.

UI: Log File Path

API: logfilepath

Path to the Intel EMA logfile.

Maximum: 247 characters

Minimum: 2 characters

UI: Maximum Number of Concurrent Database
Connections

API: maxdbconnections

The maximum number of concurrent database connections for
this server.
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Setting Description
UI: USBR Images Root Directory

API: usbrImagesRootDirectory

The root directory on the Intel EMA server where uploaded
bootable image files (.iso and .img) are stored. Default value is
C:\ProgramData\Intel\EMA\USBR.

Note: If this folder is changed by the Global Administrato
arfter images have been uploaded, the files will not be vis-
ible or available to other users like the Tenant Admin-
istrator. The Global Administrator (system administrator)
will need to manually copy the content from the original
folder to the new folder before other users can access the
files.

UI: Maximum USBR Image Storage Capacity per
Tenant

API: maxUsbrImageStorageCapacityPerTenant
InGigabytes

Disk space in GB each tenant is allowed for USBR image
storage.

Default: 20 GB

Maximum: 50 GB

UI: Maximum USBR Image storage Capacity Per
EMA Instance

API: maxUsbrImageStorageCapacityPer
EmaInstanceInGigabytes

Total disk space in GB (for all tenants) allowed in this Intel
EMA instance for USBR image storage.

Default: 50 GB

Maximum: 500 GB

UI: Maximum USBR Slot Count per Tenant

API: maxUsbrSlotCountPerTenant

Number of active USBR sessions allowed for each tenant.

UI: Maximum USBR Idle time

API: maxUsbrIdleTimeInMinutes

Length of time in minutes a USBR session can be idle before
being automatically terminated.

UI: USBR Redirection Manager Loop Interval

API: usbrRedirectionManagerLoopIntervalIn
Seconds

Status polling interval in seconds for active USBR sessions.

UI: USBR Redirection Throttling Rate

API: usbrRedirectionThrottlingRateIn
Milliseconds

The delay in sending USBR file data to the target endpoint's Intel
AMT firmware. This is needed in order to throttle the data rate, as
certain internal data flows within Intel EMA do not work properly
if the data rate is too high.

Note: CIRA based provisioning is highly recommended
when using USBR. USBR is sensitive to latency and Intel
EMA has optimized USBR for CIRA provisioned end-
points. If you are using TLS with relay, you will need to
adjust the “USBR Redirection Throttling Rate” under the
Manageability Server section in Server Settings as a
Global Admin. This setting is dependent upon your
unique network environment. We recommend starting at
a setting of 10 milliseconds and increasing it in incre-
ments of 10 until you find a rate that works well in your
network environment. It is unlikely you would need to go
above of 50 milliseconds. Note that increasing this setting
will decrease the USBR boot performance, especially for
CIRA endpoints, and should only be used for TLS with
relay only instances.

Default value: 0, max value 1000, min value 0. 

Suggested value = start at 10, increment by 10 to find
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Setting Description
appropriate rate for your network.

UI: File Upload Retention Period

API: fileUploadRetentionPeriodInDays

Number of days an incomplete resumable file upload would be
kept, after which it would be automatically deleted.

UI: File Upload Cleanup Interval

API: fileUploadCleanupIntervalInHours

Interval in hours that file cleanup process would run to process
incomplete resumable files.

UI: Swarm Servers

API: swarmserver

List of active Swarm Servers. Includes Server ID and Server IP
& Port (format IP Address: port).

UI: Server IPs

API: serverIps

List of machine IP addresses where this component server type
is running. For example, if the Manageability server is running
on machine ip1, ip2, and ip3, then serverIps will include all
IP addresses

UI: Message Port

API: messagePort

The TCP port this component server type is listening on to
accept internal traffic from other Intel EMA components. Default
8094.

UI: Audit Log Cleanup Interval (Hours)

API:  AuditLogCleanupIntervalInHours

Interval in hours before cleanup of audit log records in the Intel
EMA database.

UI: Audit Log Retention Period (Days)

API:  AuditLogRetentionPeriodInDays

Interval in days before cleanup of audit log records in the Intel
EMA database.

UI: Enable 8021X Certificate Auto Renewal

API: Is8021XCertificateRenewalEnabled

Boolean, default "True." Used to determine whether automatic
802.1x certificate renewal flows are enabled. If enabled, Intel
EMA automatically renews certificates that will be expiring soon.

UI: 802.1X Certificate Renewal Window (Days)

API: Ieee8021xCertificateRenewalWindowDays

Integer. Sets the number of days prior to an 802.1x certificate's
expiration at which Intel EMA flags that certificate for renewal.

Default: 30

Maximum: 90

Minimum: 1

UI: Enable Provisioning TLS Certificate
Revocation Check

API: enableProvisioningTLSCertCRLCheck

Boolean. Enables or disables Certificate Revocation List (CRL)
checking for the provisioning TLS certificate provided by the
client Intel AMT systems in TLS provisioning flows. CRL
checking requires the Manageability Server to have an active
internet connection for periodic downloads of the CRL files.

Default: True.

6.4 Web Server
Note: Use the Save and Sync Web Settings button to restart the web server. Alternatively, you can run the
Intel EMA installer EMAServerInstaller.exe (as Administrator) and select Settings > Sync Web Server Set-
tings from the menu bar.

Setting Description
UI: Access Token Time to Live

API: AccessTokenTimeToLive

Expiration duration of the API bearer token, in seconds.

UI: Ajax Server Host Hostname or IP address of the Ajax server, or the load balancer of the Ajax
servers.
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Setting Description
API: AjaxServerHost

UI: Enable Allowed Domains,
Allowed Domains

API: EnableAllowedDomains,
AllowedDomains

Used by the Ajax server. If enabled, the web server checks incoming
Ajax/websocket requests to accept or reject.

AllowedDomains is a comma delimited list with example
test1.intel.com,test2.intel.com.

EnableAllowedDomains is 0 (false) or 1 (true).

UI: Log File Path

API: logfilepath

Path to the Intel EMA logfile.

Maximum: 247 characters

Minimum: 2 characters

UI: Maximum Number of
Concurrent Database Connections

API: maxdbconnections

The maximum number of concurrent database connections for this server.

UI: Swarm Server Host

API: SwarmServerHost

Hostname or IP address of the Swarm server, or the load balancer of the
Swarm servers.

UI: Swarm Server Port

API: SwarmServerPort

8080 in single server installation or the Swarm server port exposed by the
swarm server load balancer in distributed server architecture.

UI: Global Catalog Port

API: GlobalCatalogPort

The port used for connecting to the Active Directory Global Catalog. This is
used to perform AD login when AD username and password are provided.
Default is 3269, which is the SSL port. See note for LDAP Connection Port
below.

UI: LDAP Connection Port

API: LdapConnectionPort

The port used for LDAP connection in 802.1x configuration. Default port is
secure 636.

Note: Intel EMA version 1.5.0 and later uses LDAPS secure ports by
default (LDAPS secure port 636 and Global Catalog port 3269). Pre-
vious versions of Intel EMA used the standard non-secure LDAP ports
(LDAP port 389 and Global Catalog port 3268). If you are installing
Intel EMA v 1.5.0 or later, and are using Active Directory or 802.1x
integration, ensure the LDAPS ports are enabled. If you prefer to use
the standard non-secure ports, then after installing Intel EMA, open the
installer program again (EMAServerInstaller.exe, run as administrator)
and select File > Advanced Mode, then click Settings > Switch from
LDAPs to LDAP to reset the LDAP ports Intel EMA uses to the stand-
ard non-secure ports. Alternatively, you can change the ports in the
Web server settings on the Server Settings page in the Intel EMA UI. If
you experience problems with 802.1x setup during Intel
AMT provisioning, this could be the issue. See the following link for
more information: https://docs.microsoft.com/en-us/troubleshoot/win-
dows-server/identity/config-firewall-for-ad-domains-and-trusts.

UI: Max Access Token TTL

API: MaxAccesstokenTTL

Maximum time for API bearer tokens to be refreshed.

UI: Frontend Storage Type

API: frontendstoragetype

Allows you to specify whether Intel EMA Website runtime information should
be stored in browser local storage or browser session storage. If Local Stor-
age is used, the session will remain (no need to login again) after the front
end website is closed. If Session Storage is used, the session is lost when the
front end website is closed.

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-domains-and-trusts
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Setting Description
UI: Azure AD Directory (tenant) ID

API: AzureAdTenantId

The Azure AD Directory (tenant) ID in GUID format. Only used when Azure
AD authentication option is selected.

UI: Azure AD Application (client) ID

API: AzureAdClientID

The Azure AD Application (client) ID in GUID format. Used with the Azure
Secret to enable the Web Server to connect to the specified Azure Tenant.
Only used when Azure AD authentication option is selected.

UI: Azure AD Client Secret Value

API: AzureAdClientSecretValue

The Azure AD Client Secret Value, only used when Azure AD authentication
option is selected. Secret will be stored in an encrypted format in the SQL
Database.

6.5 Security Settings
Most of the security settings below apply across the component servers, although some apply only to a specific
component server (for example, the Ajax server). Many of these settings are intended to help prevent Denial of
Service (DoS) attacks.

Note: If you change security settings for any of the component servers, you must restart all the component
servers, not just the one whose settings you changed (in a distributed server architecture, you must do this
on all server machines). Also, you will need to recycle the Intel EMA web site's IIS application pool to restart
the Intel EMA web server when you change these settings.

Setting Description
UI: Unauthorized TCP connection timeout

API: enableUnauthTcpConnectionIdle
Timeout

Boolean. When enabled Intel EMA will terminate new TCP
connections that go idle and do not complete the SSL
handshake to help prevent Denial of Service attacks.

Default: true.

UI: TCP connection timeout

API: unauthTcpConnectionIdleTimeout
InMilliSeconds

The amount of time in milliseconds a new TCP TLS
connection has to complete SSL handshake before the
connection is considered idle and terminated.

Default: 5000

Maximum: 3,600,000 (1 hour)

UI: Rate Limiter

API: enableRateLimiter

Boolean. When enabled Intel EMA will perform per-IP
address HTTPS/TCP TLS request rate limiting to help
prevent Denial of Service attacks.

Default: true.

UI: Rate Limiter Window Size

API: rateLimiterWinSizeInMilliSeconds

The window size in milliseconds to use for tracking
requests with per-IP address rate limiting.

Default: 200

Maximum: 3,600,000 (1 hour)

UI: Ajax HTTP Requests Max Count

API: ajaxHttpRateLimiterMaxCount

The maximum number of allowed requests per-IP address
in a window before requests would be rejected to the Ajax
Server Web redirection port (8084).

Default: 20

Maximum: 1,000,000

UI: Recovery HTTP Requests Max Count

API: recoveryHttpRateLimiterMaxCount

The maximum number of allowed requests per-IP address
in a window before requests would be rejected to the
Recovery Server Web redirection port (8085).
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Setting Description
Default: 20

Maximum: 1,000,000

UI: Message Ports Requests Max Count (Before
Authorization)

API: blastMessageBeforeAuthRateLimiterMaxCount

The maximum number of allowed pre-authentication
requests per-IP address in a window before requests would
be rejected to the internal component-to-component ports
(8092, 8093, 8094).

Default: 100

Maximum: 1,000,000

UI: Message Ports Requests Max Count (After
Authorization)

API: blastMessageAfterAuthRateLimiterMaxCount

The maximum number of allowed post-authentication
requests per-IP address in a window before requests would
be rejected to the internal component-to-component ports
(8092, 8093, 8094).

Default: 80,000

Maximum: 1,000,000

UI: Swarm Admin Ports Request Max Count (Before
Authorization)

API: adminPortBeforeAuthRateLimiterMaxCount

The maximum number of allowed pre-authentication
requests per-IP address in a window before requests would
be rejected to the Swarm Server Admin port (8089).

Default: 20,000

Maximum: 1,000,000

UI: Swarm Admin Ports Request Max Count (After
Authorization)

API: adminPortAfterAuthRateLimiterMaxCount

The maximum number of allowed authenticated requests
per-IP address in a window before requests would be
throttled to the Swarm Server Admin port (8089).

Default: 20,000

Maximum: 1,000,000

UI: Agent Port Request Max Count (Before
Authorization)

API: agentPortBeforeAuthRateLimiterMaxCount

The maximum number of allowed pre-authentication
requests per-IP address in a window before requests would
be rejected to the Swarm Server Agent port (8080).

Default: 20

Maximum: 1,000,000

UI: Agent Port Request Max Count (After
Authorization)

API: agentPortAfterAuthRateLimiterMaxCount

The maximum number of allowed authenticated requests
per-IP in a window before requests would be throttled to the
Swarm Server Agent port (8080).

Default: 1000

Maximum: 1,000,000

UI: Connection Count Check

API: enableConnectionCountChecker

Boolean. When enabled Intel EMA will limit the TCP TLS
connection count per-IP address to help prevent Denial of
Service attacks.

Default: true.

UI: Message Port (connections per port)

API: blastMessageConnCountChecker

The maximum number of connections per-IP address
allowed to the internal component-to-component ports
(8092, 8093, 8094).

Default: 20

Maximum: 1,000,000
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UI: Admin Port (connections per port)

API: swarmAdminPortConnCountChecker

The maximum number of connections per-IP address
allowed to the Swarm Server Admin port (8089).

Default: 20,000

Maximum: 1,000,000

UI: Swarm Agent Port (connections per port)

API: swarmAgentPortConnCountChecker

The maximum number of connections per-IP address
allowed to the Swarm Server Agent port (8080).

Default: 20,000

Maximum: 1,000,000

UI: User password minimum length

API: userPasswordMinLength

Used to customize policy for password validation.

Default: 8

Minimum: 8

Maximum: 20

UI: User password maximum length

API: userPasswordMaxLength

Used to customize policy for password validation.

Default: 255

Minimum: 64

Maximum: 255

UI: Client Credentials minimum length

API: clientCredentialsMinLength

Used to customize policy for password validation.

Default: 12

Minimum: 12

Maximum: 20

UI: Client Credentials maximum length

API: clientCredentialsMaxLength

Used to customize policy for password validation.

Default: 255

Minimum: 64

Maximum: 255

UI: Complexity required (uppercase/
lowercase/special char)

API: passwordComplexityRequired

Used to customize policy for password validation.

True/False.

Default: True

UI: Password Disallowed List Checking

API: PasswordDisallowedListChecking

Boolean. When it is enabled and user authentication
(username/password) is used, if a new user is created or a
current user has password updated, the supplied password
will be checked against a disallowed password list. This list
can be customized by using the Installer Advanced Mode.

Default: True.

6.6 Recovery Server Settings
The settings below are provided to support future Intel platforms.

Setting Description
UI: Log File Path Path to the Intel EMA logfile.
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API: logfilepath Maximum: 247 characters

Minimum: 2 characters

UI: Maximum Number of
Concurrent Database Connections

API: maxdbconnections

The maximum number of concurrent database connections for this server.

UI: Message Port

API: messagePort

The TCP port this component server type is listening on to accept internal
traffic from other Intel EMA components. Default 8095.

UI: Recovery Port

API: RecoveryPort

Port to be used for recovery. Default 8085.

Note: If you change the default port, you will be prompted to update
port bindings by running the following commands in admin mode on
each recovery server in this Intel EMA installation (items in brackets <>
are provided in the prompt popup dialog):

netsh http delete sslcert ipport=<original port
number>

netsh http add sslcert ipport=<new port number>

certhash=<certificate hash>

appid={3a6739cf-6707-4623-a073-34b6b7a51b1d}

UI: Recovery Port Enabled

API: RecoveryPortEnabled

Boolean, default "True." Specifies whether or not the recovery port is enabled.

UI: Server IPs

API: serverIps

List of machine IP addresses where this component server type is running.
For example, if the Ajax server is running on machine ip1, ip2, and ip3, then
serverIps will include all IP addresses.
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7 Appendix – Domain/Windows
Authentication Setup
The Intel® EMA installer sets up the fundamental settings for domain/Windows authentication if it is installed under
domain/Windows authentication mode. However, there are many different network infrastructure scenarios. Some
of the scenarios require the IT administrators to perform extra steps.

7.1 Server Connection Information Set at Installation
While running the Intel EMA installer, at the hostname field of External Identity setup, we suggest using the NetBIOS
hostname or NetBIOS FQDN of your machine in the Hostname field. You still need to make sure that other
endpoints or other client web browsers can connect to the value you entered here. You can find your NetBIOS
name by right-clicking This PC in Windows File Explorer, and choosing Properties.

If you decide to use another value (e.g., in a load balancing scenario), follow IT practice to set up the Service
Principle Name (SPN) after Intel® EMA is installed.

7.2 IIS Website’s Authentication and .NET Authorization
Intel EMA sets the following properties (differently from most default IIS website setups) for the Intel® EMA website
when it is installed under domain/Windows authentication mode:

l At IIS \ Authentication, also enable “Anonymous Authentication” with “Application Pool Identity”

l At ASP.NET \ .NET Authorization Rules, “Anonymous Users” need to be allowed

Please double check that these properties are set correctly.

7.3 Optional – Grant Permission to Website Content
There are several options for setting up this permission, e.g., NTFS or URL Authorization. IT administrators need to
set it up based on their specific infrastructure need.

7.4 Optional – Double-hop Structure
In a normal Intel EMA installation, you don’t need to do this. However, if you need to support special double-hop
authentication, e.g., passing the logged-in credential to another backend server, then you need to set up several
extra settings, e.g., Delegation at AD’s Computer object for your server machine. Please follow standard IT practice.

7.5 References
l https://blogs.msdn.microsoft.com/webtopics/2009/01/19/service-principal-name-spn-checklist-for-kerberos-
authentication-with-iis-7-07-5/

l https://weblogs.asp.net/owscott/iis-using-windows-authentication-with-minimal-permissions-granted-to-disk

l https://docs.microsoft.com/en-us/iis/-
configuration/system.webserver/security/authentication/anonymousauthentication

l https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-
2012/hh831722(v=ws.11)

https://blogs.msdn.microsoft.com/webtopics/2009/01/19/service-principal-name-spn-checklist-for-kerberos-authentication-with-iis-7-07-5/
https://blogs.msdn.microsoft.com/webtopics/2009/01/19/service-principal-name-spn-checklist-for-kerberos-authentication-with-iis-7-07-5/
https://weblogs.asp.net/owscott/iis-using-windows-authentication-with-minimal-permissions-granted-to-disk
https://docs.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/anonymousauthentication
https://docs.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/anonymousauthentication
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/hh831722(v=ws.11)
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/hh831722(v=ws.11)
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8 Appendix – Configuring 802.1X for Active
Directory
This section is intended for Intel® EMA Global Administrators who want to enable 802.1X authentication for Intel®
AMT. If your Tenant Administrators plan to configure 802.1x profiles for use in their Tenant-specific Intel AMT
profiles, the Global Administrator must configure 802.1x for Active Directory Domain Services, specifically an Active
Directory Organizational Unit (OU) and Active Directory Certificate Service certificate template, as described in this
section. Note that the configuration described here is just one possible configuration. Those highly familiar with
802.1x configuration may wish to deviate from this configuration.

Intel EMA supports Extensible Authentication Protocol (EAP).

Note: This section focuses on configuration for the Intel EMA server system to enable 802.1x authentication
at the overall server level as a prerequisite for configuring 802.1x profiles for a specific Tenant in Intel EMA.
For information on configuring an 802.1x profile for a specific Tenant usage space, see the Intel® EMA
Administration and Usage Guide.

8.1 Active Directory Domain Services
During Intel AMT configuration of an endpoint, Intel EMA creates an Intel AMT computer object (identified by -iME
suffix) within the AD OU as defined in the 802.1x profile. This object is used by Intel AMT to support Kerberos
authentication. Note that the AD OU requires full permissions for the user account running the Intel EMA
Manageability Server. Follow the steps below to create an AD OU for this purpose.

1. Add an Organization Unit to the AD Domain to which the endpoint belongs. The example below uses the
domain VPRODEMO.COM and the Organizational Unit, VProDevComputers.

Figure 1: Add a new Organization Unit

2. Add privileges for the Intel EMA server user account.
a. Add the user account or a security group to which the user account belongs to the Security tab of the

Organizational Unit where the AD Computer objects for 802.1X authentication will be created.
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Ensure that this account or security group has all available permissions allowed, and edit the
Advanced Security Settings to apply this group's privileges to “This object and all descendant
objects.”

Figure 2: Modify Security list of the OU

Figure 3: Modify advanced security settings

8.2 Active Directory Certificate Services
Note: This section is not required for EAP_PEAP_MSCHAP_V2.

EAP-TLS mandates that a Client Authentication and Trusted Root certificates are required. The Intel AMT 802.1x
client certificate requires an Active Directory Certificate Service certificate. A duplicate of the Workstation
authentication template with the specific properties described in step 2 below can be used.

1. Choose the Certification Authority (Enterprise root CA) that is associated with your specific 802.1x envir-
onment configuration; the example below uses VPRODEMO-WIN-GUVUHKBNQ69-CA.
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Figure 4: Certification Authority list

2. Create a Certificate Template: AMTComputer. This is a duplicate template based on the Workstation
Authentication template.

Figure 5: Certificate Templates list

a. Right-click AMTComputer and select Properties.

b. On the Subject Name tab, select Supply in the request.

c. On the Request Handling tab, if you plan to use the Microsoft Certificate Authority for certificate con-
figuration under Client Authentication in your 802.1x profile (recommended, see the Intel® EMA
Administration and Usage Guide), leave the box Allow private key to be exported unselected (recom-
mended). If you plan to select "From Database" instead of Microsoft Certificate Authority in your
802.1x profile, then select this checkbox.

d. On the Security tab, grant Read and Enroll permission to Domain Computers. (Also add Everyone
for manual enrollment.)

e. Enable the template in the Certification Authority (right-click on Certificate Template and select New
> Certificate Template to Issue).
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9 Appendix - Updating a Single Server
Architecture Environment
If you are updating an existing Single Server Architecture installation of Intel EMA, follow the procedures in this
appendix.

Update Installation Notes:

l When upgrading an Intel EMA instance, the account under which the Platform Manager service runs
reverts to Local System. If you are running that service under another local or domain account, it will
need to be reconfigured and all Intel EMA components halted and restarted after the upgrade is
complete.

l If you are updating from an existing version of Intel EMA, the Intel EMA website’s bindings in IIS will
be set to default values during the update installation. You can check the log files after installation to
find the pre-update bindings for your reference.

l The Intel EMA Agent software on managed endpoints is automatically updated upon connecting to
the updated Intel EMA server instance for the first time after server update. For Intel EMA version
1.5.0 and later, this automatic update is only performed if the Swarm Server setting Agent Auto
Update is enabled (default). See section 6.1 for details.

l For updates from previous Intel EMA versions, the installer detects the connection string auto-
matically.

9.1 Updating Using the Setup Wizard
Extract the installation ZIP file, open the folder, and
right-click on EMAServerInstaller.exe and select Run
as administrator. The installer opens and the status
bar at the bottom shows Ready if the initial checks
have passed.

Click the top-left icon to begin the installation process.

Note: For assistance, click Help > Intel
Support

The installer detects that you are performing an
update installation and informs you that your IIS
web.config file will be renamed to allow an updated
file to be installed.

Click OK.
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Click Next on the Welcome screen to continue the
setup process.

Note: The warning regarding IIS being
installed does not apply to update
installations.

Select Single Server Architecture. This screen is only
displayed if you are updating from a version prior to
v1.6.0.

IMPORTANT! Selecting an installation type
that does not match your existing installation
will result in a non-functioning Intel
EMA instance that will need to be fully unin-
stalled and reinstalled. Make sure the type you
select matches the type that is currently
installed. This action cannot be undone once
you complete the update.

Click Next.

9.1.1 Database Settings

Note: For update mode, the fields are filled in and
cannot be changed.
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9.1.2 Platform Manager Configuration

External Port is used by the Intel® EMA Platform
Manager service running on this Intel EMA server to
accept connection from the Intel EMA Platform Manager
client application. Make sure that the port you specify is
open in the underlying network.

This screen cannot be edited in update mode.

9.1.3 Summary

Review your installation settings and then click Install.

All required Windows components will be installed,
followed by the Intel® EMA software itself.

IMPORTANT: Do not abort or exit the installer
until installation is complete. Installation rollback
is not supported.

Installation status is shown at the bottom of the Installer
main menu. Installation options are unavailable during
installation.

To check the log file during installation, click File >
Advanced Mode. To exit Advanced Mode, click File >
Advanced Mode again.

After installation, you can check the logfile EMALog-
Intel®EMAInstaller.txt in the same folder as the Intel
EMA installer.

9.2 Updating Using the Command Line
Use the command example below to update the Intel EMA server machine.

EMAServerInstaller FULLINSTALL --updateinstalltype=single --accepteula -c -v
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